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About this book

This book provides instructions for installing and configuring IBM®  Software 
Configuration and Library Manager (SCLM) Suite Administrator Workbench.

This book is designed to help SCLM project administrators and installation personnel 
perform these tasks:

• Plan for and install SCLM Suite Administrator Workbench

• Customize the  SCLM Suite Administrator Workbench environment

• Diagnose and recover from SCLM Suite Administrator Workbench problems

• Use SCLM Suite Administrator Workbench with other products comprising IBM’s 
SCLM Suite.

This manual is a companion to the IBM SCLM Suite Administrator Workbench: User’s 
Guide,  SC31-6571.   The User’s Guide provides information required to use the SCLM 
Suite Administrator Workbench to define, modify, and administer SCLM projects 
from either a client workstation or host ISPF panels, and to administer IBM Enhanced 
Access Control for SCLM for z/OS® from a client workstation.  

Always check the SCLM Suite Administrator Workbench Library page for the most 
current version of these publications:  

http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library/

Who should read this book

This book is intended for those persons responsible for installing and customizing 
SCLM Suite Administrator Workbench and assumes a working knowledge of:

• The z/OS operating system

• IBM WebSphere® Studio Workbench 

• ISPF

• SCLM

• SMP/E

• RACF®, if administering IBM Enhanced Access Control for SCLM for z/OS

• TCP/IP

Conventions and terminology used in this book

This book uses the following highlighting conventions:

• Boldface type indicates commands or user interface controls such as names of 
fields, folder, icons, or menu choices.

• Monospace type indicates examples of text that you enter exactly as shown.

• Italic type indicates variables that you should replace with a value. It is also used 
to indicate book titles and to emphasize significant words.

The following labels identify significant elements within this book:

• Definition: is used to identify and define terminology unique to this product.

• Example: is used to identify example code or scenarios.
© Copyright IBM Corp.  2004  v
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• In this chapter: is used to identify the significant subsections within each chapter.

• Recommendation: is used to provide guidance when more than one option is 
available.

• Related reading: is used to refer you to other publications that contain relevant 
information.

• Restriction: is used to identify a restriction or limitation with this product or an 
associated procedure.

Terminology used in this book

In this book, IBM Software Configuration and Library Manager (SCLM) Suite 
Administrator Workbench for z/OS is referred to as “SCLM Suite Administrator 
Workbench.”  IBM Enhanced Access Control for SCLM for z/OS is referred to as 
"Enhanced Access Control for SCLM."  IBM Breeze for SCLM for z/OS is referred to as 
"Breeze".

Service updates and support information

To find service updates and support information, including software FixPaks, PTFs, 
Frequently Asked Question (FAQs), technical notes, troubleshooting information, and 
downloads, refer to the following Web page:

http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library

Using LookAt to obtain message explanations

LookAt is an online facility that displays explanations for most messages that you 
encounter, as well as for some system abends and codes. You can access LookAt: 

• From the Internet at:

www.ibm.com/eserver/zseries/zos/bkserv/lookat/

• From anywhere in z/OS where you can access a TSO/E command line (for 
example, a TSO/E prompt, ISPF, or z/OS UNIX System Services running OMVS). 
To use LookAt as a TSO/E command, LookAt must be installed on your host 
system. Obtain the LookAt code for TSO/E from a disk on your z/OS Collection 
(SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/ZOS/

• From your Palm™ VIIx personal data assistant (PDA). To use LookAt from your 
Palm VIIx PDA, LookAt must be installed on the PDA. Obtain the LookAt code 
from a disk on your z/OS Collection (SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/PALM/

 

Where to find information

The SCLM Suite Web page and web pages for the component products of the SCLM 
Suite provide current product documentation that you can view, print, and download. 
To locate publications with the most up-to-date information, refer to the following 
Web pages:  

http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library/

IBM Redbooks® that cover the SCLM Suite are available from the following Web page:
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Information about configuring your MVS system for client-host communications can 
be found in the z/OS Communications Server library, available from the following 
web page:

www-1.ibm.com/servers/eserver/zseries/zos/bkserv/r5pdf/commserv.html

Information about UNIX System Services can be found in the UNIX System Services 
library, available from the following web page:

http:www-1.ibm.com/servers/eserver/zseries/zos/unix/bpxa1pub.html

Accessibility features

Accessibility features help a user who has a physical disability, such as restricted 
mobility or limited vision, to use a software product successfully. The major 
accessibility features in SCLM Suite Administrator Workbench enable users to:

• Use assistive technologies such as screen readers and screen magnifier software. 
Consult the assistive technology documentation for specific information when 
using it to access z/OS interfaces.

• Customize display attributes such as color, contrast, and font size.

• Operate specific or equivalent features using only the keyboard. Refer to the 
following publications for information about accessing ISPF interfaces:

— z/OS ISPF User’s Guide, Volume 1, SC34-4822

— z/OS TSO/E Primer, SA22-7787

— z/OS TSO/E User’s Guide, SA22-7794

These guides describe how to use ISPF, including the use of keyboard shortcuts or 
function keys (PF keys), include the default settings for the PF keys, and explain 
how to modify their functions.

Additional accessibility information is found in this manual in Appendix B, 
“Accessibility Features of the Workstation Component,” on page 59.

Navigating in a workstation panel

When you use the Tab key to navigate through a workstation panel, as you move from 
field to field, one of the letters in each of the descriptions is underlined.  This provides 
a keyboard shortcut to the field in question.  This behavior does not occur when using 
the mouse to select a field on the panel.

Copying and pasting while using the workstation interface

If you want to copy information from a text field or paste information into a text field, 
place your cursor in the field in question.  To copy, select the text to be copied, right-
click in the text field, and select Copy from the pop-up menu.  To paste information 
into a text field, place your cursor into the field in question, right-click, and select 
Paste from the pop-up menu.  Currently, the use of Ctrl+C and Ctrl+V, respectively, 
are not supported in all text fields.
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How to send your comments

Your feedback is important in helping to provide the most accurate and high-quality 
information. If you have any comments about this book or any other SCLM Suite 
Administrator Workbench documentation:

• Use the online reader comment form located at: 

http://www-3.ibm.com/software/awdtools/rcf/

• Send your comments by e-mail to dmtinfo@us.ibm.com. Be sure to include the 
name of the book, the part number of the book, the version of SCLM Suite 
Administrator Workbench, and, if applicable, the specific location of the text you 
are commenting on (for example, a page number or table number).

• Print and fill out the reader comment form located at the  back of this book. You 
can either give the completed form to your local IBM branch office or IBM 
representative, or you can send it to the address printed on the  reader comment               
form.

Summary of Changes

The SCLM Suite Administrator Workbench Installation and Customization Guide, GC31-
6787-01, contains the following enhancements or changes:

• The required level of Remote Systems Explorer is Version 6.0.3. The RSE 6.0.3 
Preference page permits you to control file cache size and clear the cache. 
However, you must not do so while an SCLM Suite Administrator Workbench 
project is open.

• You are no longer required to customize setup.env.zseries.  This is now done for 
you automatically.  The discussion of setup.env.zseries has been removed from 
this book.

• Changes have been made to ispf.sh, setup.sh, auz.clist, and auz.unpax.

• SAUZLOAD and the XML LOADLIBs on MVS must be APF-authorized.

• By default, you will not see the ISPF log in the spool.  Instructions are provided in 
“Customizing setup.sh” on page 20.

• An installation verification program (IVP) is distributed with the product.  The 
instructions for running the IVP are found in Chapter 4, “The Installation 
Verification Program,” on page 27.

In addition, SCLM Suite Administrator Workbench now provides an improved 
method of navigating through the product when using the ISPF interface.  You can 
read about it in the SCLM Suite Administrator Workbench User’s Guide.

In this current Installation and Customization Guide, GC31-6787-02, a program has been 
added that simplifies the customization of ispf.sh and setup.sh.  You may, however, 
continue to customize these scripts manually, if you so desire.
 viii IBM Software Configuration and Library Manager Suite Administrator Workbench: Installation and Customization Guide  
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Part 1. Introduction

This part describes the IBM Software Configuration and Library Manager (SCLM) 
Suite Administrator Workbench.
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Chapter 1. About the SCLM Suite Administrator Workbench

IBM's SCLM is a program that provides software configuration and library 
management for the z/OS and OS/390® platforms. Using the SCLM Suite 
Administrator Workbench, you can address the complexity of setting up an SCLM 
project initially, performing day-to-day project maintenance, and managing access 
control from a workstation. It provides the  simplicity and functionality you need at 
an attractive cost. 

Because SCLM Suite Administrator Workbench provides both a GUI and an ISPF 
interface,  you can work in the environment in which you're most comfortable.  While  
SCLM Suite Administrator Workbench functions run primarily in the foreground, the 
product supports both batch and online execution for project creation, project cloning, 
and VSAM file maintenance.  You can choose immediate response when you require 
it, or can defer processing to a more convenient time.  You specify where these 
functions are to run from the Window pulldown by specifying Preferences > SCLM 
Admin Workbench.

You can get started easily with SCLM Suite Administrator Workbench by invoking the 
SCLM Project Wizard, either from a workstation or from an ISPF host session, to 
create a new project or modify an existing one.  When creating a new project, the 
fields in the Project Wizard will be populated with default values.  When modifying 
an existing project, the fields contain that project’s defined values.

Using the Project Wizard, you can define the elements that comprise your project.  As 
you enter data into the Project Wizard, that data is saved at the host.  Thus, at any 
time, you can choose to stop work before you have fully defined the project.  SCLM 
Suite Administrator Workbench saves your work so that you can pick it up in a later 
session.

When defining a group using the workstation interface, you can drag and drop boxes 
around your display, building a network of linked boxes much like an organization 
chart. Each box represents an SCLM group.  Once you have completed your 
definition, SCLM Suite Administrator Workbench generates default authorization 
codes and PROMOTE definitions, which you can modify if you so choose. A  process 
to add or modify groups is also available at the host using ISPF panels. 

Using the Project Wizard, you can  configure any user exits you may require, 
including the Breeze user exits, if you have installed Breeze.  You can add language 
types, or you can modify them using the Language Definition Wizard.

Other functions provided by the SCLM Suite Administrator Workbench include:

• The ability to update and run your VSAM tasks and perform VSAM file 
maintenance

• The ability to create architecture definitions manually or by importing them from 
existing JCL or an existing Load Module, guided by the Architecture Definition 
Wizard

• The ability to easily clone an existing project and, if you so desire, its data

You can update and manage SCLM projects that have not been created by SCLM Suite 
Administrator Workbench, provided that these projects use simple SCLM macros and 
the project definitions are not contained within macros as might be done, for example, 
to support conditional project construction.  
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Support for Enhanced Access Control for SCLM Administration

Enhanced Access Control for SCLM is a program that enhances RACF security.  The 
SCLM Suite Administrator Workbench assists you in administering Enhanced Access 
Control for SCLM by:

• Maintaining existing RACF Data Set Profiles,  Enhanced Access Control for SCLM 
Rules Files,  Enhanced Access Control for SCLM Profile Access Rules, and 
Enhanced Access Control for SCLM Applications

• Displaying a list of Enhanced Access Control for SCLM Violations

For additional information about the Enhanced Access Control for SCLM 
administration tasks supported by SCLM Suite Administrator Workbench, see the 
SCLM Suite Administrator Workbench User’s Guide.

Hardware and software requirements

When describing system requirements for installing and using SCLM Suite 
Administrator Workbench, the following terminology is used:

• The driving system is that system used to install the product

• The target system is that system on which the product is installed

The sections that follow provide an overview of the hardware and software 
requirements to run SCLM Suite Administrator Workbench. Current and complete 
information, including any required APARs and PTFs is found in the SCLM Suite 
Administrator Workbench Program Directory.

Note:   When using the Linux and UNIX ports, SCLM Suite Administrator Workbench 
is an X-Client Application. It may be sensitive to the X-Server being used if this is not 
the X-Server located on the system. We have tested successfully with Exceed and 
XLite Pro v1.2 under Windows. 

Hardware requirements

Required hardware is any hardware environment that supports the required software 
as described in “Software requirements”.

Software requirements

The driving system software requirements may be any one of the following:

• OS/390 V02.10.00

• z/OS V01.02.00 or later

• IBM SMP/E for z/OS and OS/390 V03.02.00 or later

The target system software requirements may be any one of the following:

• XML Toolkit for z/OS V01.04.00 or V01.06.00.

• Java V01.03.01, the May, 2003, or later revision

• Any one of the following:

— OS/390 V02.10.00

— z/OS V01.02.00 or later

— IBM SMP/E for z/OS and OS/390 V03.02.00 or later

Note:  Remote Systems Explorer (RSE) must be at level 6.0.3.
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Part 2. Installation and Customization

This part describes planning for the installation and customization of SCLM Suite 
Administrator Workbench and performing the installation and customization 
activities  that you will need to undertake.  Typically, the installation and 
customization activities on the host are the responsibility of a systems programmer, 
while installing and customizing each workstation client is the responsibility of that 
client’s user.
© Copyright IBM Corp.  2004  5
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Chapter 2. Planning for Installation

Before installing and customizing SCLM Suite Administrator Workbench, there are 
decisions you should  make and planning activities you should undertake.  Various 
people at  your site may need to be involved in these decision and  planning activities. 

Gather the required information

SCLM Suite Administrator Workbench provides several kinds of information that will 
aid you with installation and customization.  One is this Installation and 
Customization Guide.  In addition to this Guide, you should gather together the 
materials you will need:

• The product’s Program Directory for information about unloading the product 
from the distribution media onto your system.  The Program Directory explains 
the program materials you have received, installation requirements and 
considerations, and detailed instructions for installing under SMP/E.

• The Read-me document.  If there is any last-minute information you need, a 
Read-me will be included as part of the installation package.

• Manuals from other product libraries that may be needed. A Bibliography is 
included in this manual that lists documentation that may be of assistance when 
installing and customizing SCLM Suite Administrator Workbench

Decide how you will use the product

SCLM Suite Administrator Workbench provides two interfaces, a GUI-compliant 
workstation client and a host-based ISPF interface.  While you can work on an SCLM 
Suite Administrator Workbench session from the client and later complete your work 
at the host, or vice versa, it is more likely that each user will pick a preferred method 
of interfacing with SCLM Suite Administrator Workbench. 

Install any required products and check the maintenance level of your 
installed products

Irrespective of whether you will use the ISPF interface or the workstation-based client 
GUI interface, you should ensure that your system has installed the following 
products and the current maintenance has been applied for:

• SCLM

• ISPF

• TSO

• TCP/IP

• UNIX System Services

• If using the workstation client, the software specific to the workstation that will be 
used

• Java Version 1.3.1 for the host system at the correct release level 

• XML Toolkit for z/OS Version 01.04.00 or Version 01.06.00
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Customize the software

Ideally, the prerequisite software has been customized prior to installing the SCLM 
Suite Administrator Workbench. The required customization is listed below, with 
details provided later in this manual. 

• CEE.SCEERUN must be link-listed

• SAUZLOAD and the XML LOADLIBs must be APF-authorized

• OMVS REXEC must be configured and operational prior to using the GUI client 
at a workstation

• Each user must have an OMVS segment in RACF, with a valid shell and home 
directory specified.

• Each user’s uid must be unique and non-zero.

• Each user must have write authority to /tmp.

• Users that will create language definitions or architecture definitions from JCL 
must have a HOLD CLASS specified in the TSO segment of their RACF user 
profile

• Each user must have the ability to specify a region size of 20000 on the TSO logon 
screen if using the ISPF interface and the XML Toolkit V1R4 is used.

• Each user must have the ability to specify a region size of 60000 on the TSO logon 
screen if using the ISPF interface and the XML Toolkit V1R6 is used.

• Users working with the EAC-specific features of SCLM Suite Administrator 
Workbench must have RACF SPECIAL authority specified in their RACF user 
profiles. 

Involve the appropriate people

In preparing to install and customize the product, you should involve the necessary 
people in planning the installation-- your site’s personnel responsible for:

• TCP/IP customization

• Security administration

• UNIX System Services configuration
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Chapter 3. Installing and Customizing the Host Component

This chapter provides information about the tasks that you must perform to install 
and customize the host component of the SCLM Suite Administrator Workbench. 
Note that, because enterprises vary in their installation requirements, the 
customization information in this chapter may not be an exhaustive list of the changes 
required to be made to your installation. 

The following tasks typically are performed by a systems programmer:

• Obtain the product and install it on your MVS™ system

• Customize your MVS system for the product

• Customize UNIX System Services (USS) and RACF.  USS is a component shipped 
as part of z/OS and OS/390. 

• Customize IBM Workload Manager (WLM)

• If you will use the workstation interface, customize TCP/IP to invoke REXEC —a 
task typically performed by the systems programmer.

• Ensure that each SCLM Suite Administrator Workbench user is properly 
configured to use the product.

If you will use only the host interface to SCLM Suite Administrator Workbench, you 
can stop here and begin using ISPF to access the product panels.

If you plan to use the workstation client, complete the tasks above and then:

• Download and install the SCLM Suite Administrator Workbench client

• Customize the client  and set up your RSE configuration

Information about installing and customizing the workstation component can be 
found in Chapter 5, “Installing and Configuring the Workstation Client,” on page 29.

SMP/E installation

Follow the directions in the Program Directory to install SCLM Suite Administrator 
Workbench on z/OS or OS/390.   Then follow the directions in this chapter to install 
and customize the MVS component of the SCLM Suite Administrator Workbench.   

Installing and customizing the MVS component

After SCLM Suite Administrator Workbench has been installed, the following post-
installation steps should be performed.

The recommended directory into which to install SCLM Suite Administrator 
Workbench is /usr/lpp/.  

 The library AUZ.SAUZLOAD, as well as either AUZ140 or AUZ160, must be link-
listed, or the member AUZAUTH must be copied into a link-listed library and
’F LLA,REFRESH’ entered on the MVS system console
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APF authorization

<hilev>.SAUZLOAD and the XML LOADLIBs must be APF-authorized. 

Customizing AUZUNPAX

The AUZUNPAX job found in <hilev>.SAUZSAMP installs the USS components in an 
HFS. This HFS must have at least 30MB of space available. The AUZUNPAX job:

1. Deletes the file tree rooted at /usr/lpp/AUZ/v110-old if it exists

2. Preserves any existing customization of this job by renaming /usr/lpp/AUZ/v110 
to /usr/lpp/AUZ/v110-old

3. Unpaxes AUZ.SAUZSAMP(AUZPAX) to /usr/lpp/AUZ/v1103

4. Renames /usr/lpp/AUZ/v1103 to  /usr/lpp/AUZ/v110 

5. Sets appropriate permissions on the files and directories rooted at  
/usr/lpp/AUZ/v110

6. Copies the setup.sh  and ispf.sh files from the relevant location in 
/usr/lpp/AUZ/v110-old, if this directory exists, to the corresponding location in  
/usr/lpp/AUZ/v110.

The AUZUNPAX job must be run by a user who can become root via the SU 
command.

If you have installed the product into a directory other than /usr/lpp/AUZ, you will 
need to modify AUZUNPAX. The directory you specify as the location in which to 
place the contents of AUZ.SAUZPAX must be one level above /AUZ/, since the 
installation process creates the AUZ subdirectory and its subdirectories (see the listing 
for AUZUNPAX, below).  In the listing, you may need to modify the following 
statements:

• INSTALL_DIR=/usr/lpp

• pax -rvf"//'AUZ.SAUZSAMP(AUZPAX)'"

You may also need to modify the CLASS, MSGCLASS, MSGLEVEL, NOTIFY, USER, 
GROUP, and PASSWORD parameters specified for the job.

Note:  When customizing the various parameters in a CLIST, you must ensure that the case of 
the values you enter must exactly match the case of the corresponding information in your 
Hierarchical File System (HFS) directory.  Thus, for example, if  the HFS directory where 
SCLM Suite Administrator Workbench resides is /usr/lpp/AUZ/v110/bin, you must ensure 
that your entry for the AUZ  CLIST SPATH shows usr, lpp, v110,  and bin in lower-case 
letters, and AUZ in upper-case letters. 
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Contents of AUZUNPAX

This section contains a listing of AUZUNPAX. You should note that AUXUNPAX as 
distributed with the product is the most current version and may differ slightly from 
the listing presented here. 

//AUZUNPAX JOB 01,
//           'Name',
//           CLASS=A,
//           MSGCLASS=8,
//           MSGLEVEL=(1,1),
//           NOTIFY=&SYSUID,
//           USER=,GROUP=,PASSWORD=
//*
//*
//* Licensed Materials - Property of IBM
//* 5655-L03
//* (c) Copyright IBM Corp. 2004 All Rights Reserved.
//* (c) Copyright Rocket Software, Inc. 2003-2004 All Rights Reserved.
//* US Government Users Restricted Rights - Use, duplication or
//* disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
//*
//*
//*  This JOB extracts the contents of Data Set
//*  AUZ.SAMPLIB(AUZPAX) to /usr/lpp/AUZ.
//*
//*  If the product has been previously installed it:
//*  a) deletes v110-old if it exists.
//*  b) renames v110 to v110-old.
//*  c) unpaxes the AUZPAX file.
//*  d) renames the directory in the PAX file to v110.
//*  e) sets the permissions appropriately.
//*  f) brings forward the prior customizations.
//*
//*  If the product has not been previously installed it:
//*  a) unpaxes the AUZPAX file.
//*  b) renames the directory in the PAX file to v110.
//*  c) sets the permissions appropriately.
//*
//*
//*  The recommended HLQ is AUZ, but if IBM SCLM Suite
//*  Administrator Workbench is not installed with the
//*  default and recommended High Level Qualifier, then you
//*  can customize this job accordingly.
//*
//*  Also, /usr/lpp is the recommended installation point,
//*  but again this can be changed to suit the site's rules.
//*
//*
//*  Note: This file contains both lower and upper case characters.

//*        The case of the text must be preserved.
//*        Also, the file must always be saved NONUM and some lines
//*        may have the backslash (\) character in column 80.
//*        These must also be preserved.
//*
//*  Note: The installation must be performed by a user who has
//*        authority to become root.
//*
//*
//STEP00   EXEC PGM=IKJEFT01
//SYSPRINT DD  SYSOUT=*
//SYSTSPRT DD  SYSOUT=*
//HFSIN    DD  PATH='/tmp/&SYSUID..in',
//           PATHDISP=(KEEP,KEEP),
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OTRUNC)
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//SYSIN    DD  *
set -x
umask 022
INSTALL_DIR=/usr/lpp
INSTALL_VER=v110
PAX_VER=v1103
PREV_VER=v110-old
BIN_DIR=${INSTALL_DIR}/AUZ/${INSTALL_VER}/bin
LOG_DIR=${INSTALL_DIR}/AUZ/${INSTALL_VER}/log
#
cd ${INSTALL_DIR}
RETCODE=$?
if [ ${RETCODE} -ne 0 ]
then
    echo "Unable to change directory, "
    echo "return code = ${RETCODE}"
    exit 255
fi
pwd
if [ -d AUZ/v110-old ]
then
{
    rm -rf AUZ/v110-old
    RETCODE=$?
    if [ ${RETCODE} -ne 0 ]
    then
        echo "Unable to delete previous version v110-old "
        echo "return code = ${RETCODE}"
        exit 254
    fi
}
fi
if [ -d AUZ/${INSTALL_VER} ]
then
{
    mv AUZ/${INSTALL_VER} AUZ/${PREV_VER}
    RETCODE=$?
    if [ ${RETCODE} -ne 0 ]
    then
        echo "Unable to backup version ${INSTALL_VER} to ${PREV_VER} "
        echo "return code = ${RETCODE}"
        exit 253
    fi
}
fi
pax -rvf "//'AUZ.SAUZSAMP(AUZPAX)'"
RETCODE=$?
if [ ${RETCODE} -ne 0 ]
then
    echo "Unable to unpax USS component, "
    echo "return code = ${RETCODE}"
    exit 252
fi
if [ ${PAX_VER} != ${INSTALL_VER} ]
then
{
    if [ -d AUZ/${PAX_VER} ]
    then
    {
        mv AUZ/${PAX_VER} AUZ/${INSTALL_VER}
        RETCODE=$?
        if [ ${RETCODE} -ne 0 ]
        then
        {
            echo "Unable to install version ${PAX_VER} to ${INSTALL_VER}, "
            echo "return code = ${RETCODE}"
            exit 251
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        }
        fi
    }
    fi
}
fi
chmod -R 755 AUZ/${INSTALL_VER}
RETCODE=$?
if [ ${RETCODE} -ne 0 ]
then
    echo "Unable to set permissions on installation tree, "
    echo "return code = ${RETCODE}"
    exit 250
fi
chmod ugo+w ${LOG_DIR}
RETCODE=$?
if [ ${RETCODE} -ne 0 ]
then
    echo "Unable to set permissions on log directory, "
    echo "return code = ${RETCODE}"
    exit 249
fi
chmod +t ${BIN_DIR}/auzauth
RETCODE=$?
if [ ${RETCODE} -ne 0 ]
then
    echo "Unable to set permissions on auzauth, "
    echo "return code = ${RETCODE}"
    exit 248
fi
if [ -d AUZ/v110-old ]
then
{
    if [ -d AUZ/${INSTALL_VER} ]
    then
    {
        cp AUZ/v110-old/bin/setup.sh AUZ/${INSTALL_VER}/bin/setup.sh
        RETCODE=$?
        if [ ${RETCODE} -ne 0 ]
        then
        {
            echo "Unable to propagate setup.sh from v110-old, "
            echo "return code = ${RETCODE}"
            exit 247
        }
        fi
        cp AUZ/v110-old/bin/ispf.sh AUZ/${INSTALL_VER}/bin/ispf.sh
        RETCODE=$?
        if [ ${RETCODE} -ne 0 ]
        then
        {
            echo "Unable to propagate ispf.sh from v110-old, "
            echo "return code = ${RETCODE}"
            exit 246
        }
        fi
    }
    fi
}
fi
exit 0
/*
//SYSTSIN  DD  *
  OCOPY INDD(SYSIN) OUTDD(HFSIN)
/*
//*
//STEP01   EXEC PGM=BPXBATCH,
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//            PARM='SH cat /tmp/&SYSUID..in|su'
//STDIN    DD  DUMMY
//STDOUT   DD  PATH='/tmp/&SYSUID..out',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OTRUNC)
//STDERR   DD  PATH='/tmp/&SYSUID..err',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OTRUNC)
//STDENV   DD  DUMMY
//SYSPRINT DD  SYSOUT=*
//*
//STEP02   EXEC PGM=IKJEFT01
//SYSTSPRT DD  SYSOUT=*
//HFSIN    DD  PATH='/tmp/&SYSUID..in',
//           PATHDISP=(DELETE,DELETE)
//HFSOUT   DD  PATH='/tmp/&SYSUID..out',
//           PATHDISP=(DELETE,DELETE)
//HFSERR   DD  PATH='/tmp/&SYSUID..err',
//           PATHDISP=(DELETE,DELETE)
//STDOUTL  DD  SYSOUT=*,
//           DCB=(RECFM=VB,LRECL=1020,BLKSIZE=1024)
//STDERRL  DD  SYSOUT=*,
//           DCB=(RECFM=VB,LRECL=1020,BLKSIZE=1024)
//SYSPRINT DD  SYSOUT=*
//SYSTSIN  DD  *
  OCOPY INDD(HFSOUT) OUTDD(STDOUTL)
  OCOPY INDD(HFSERR) OUTDD(STDERRL)
/*
//*
//

Customizing AUZFLMRN

After SCLM Suite Administrator Workbench has been installed, it is added to a 
modified SCLM Main Menu as Option 8.  In order to display the modified SCLM 
Main Menu that includes the SCLM Suite Administrator Workbench option, you must 
take the following steps:

1. Customize the job AUZ.SAUZSAMP(AUZFLMRN) for your installation.  This job 
renames the AUZFLMD panel member to FLMDMN and is needed to display the 
SCLM Main Menu with the SCLM Suite Administrator Workbench option. 

2. Run job AUZ.SAUZSAMP(AUZFLMRN).

3. Modify your users’ logon PROCs so that AUZ.SAUZPENU is placed ahead of 
ISP.SISPPENU in the ISPPLIB concatenation.  Alternatively, copy 
AUZ.SAUZSAMP(FLMDMN) to such a library.  This causes the SCLM Suite 
Administrator Workbench version of FLMDMN to be used instead of the version 
provided with ISPF.

Customizing the AUZ CLISTs

To start the SCLM Suite Administrator Workbench user interface, you run the SCLM 
Suite Administrator Workbench CLISTs. Before doing so, you must first customize 
two CLISTs, AUZ and AUZCLIST, located in the SAUZSAMP sample library, to work 
in your environment.  Then, copy the customized CLISTs from AUZ.SAUZSAMP to a 
CLIST library that is in all users’ SYSPROC concatenation for CLISTs, or modify each 
user’s logon procedure to include AUZ.SAUZSAMP in the concatenation.
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SCLM Suite Administrator Workbench CLIST Member AUZ

The statements comprising member AUZ execute the contents of member AUZCLIST. 
The statements within member AUZ  allow you to start the SCLM Suite 
Administrator Workbench user interface CLIST, AUZCLIST, as a separate application. 
This enables you to continue your ISPF session should you encounter a problem with 
this particular instance of SCLM Suite Administrator Workbench. The contents of the 
SCLM Suite Administrator Workbench CLIST member AUZ are shown below.  You 
should note that this CLIST as distributed with the product is the most current 
version and may differ slightly from the listing presented here.

To customize  member AUZ, perform the following steps:

1. Copy the AUZ  and AUZCLIST members to a CLIST library that is included in all 
users’ SYSPROC concatenation. You must do so in order to execute the AUZ 
CLIST using TSO.

2. In the PROC 0 CLISTLIB(name) statement, specify the name of the data set to 
which the AUZCLIST member was copied. For example, 
PROC  0 CLISTLIB(ABCD.USER.CLIST)

Contents of AUZ:  

PROC 0 CLISTLIB(name)    

//* LICENSED MATERIALS - PROPERTY OF IBM
//* 5655-L03
//* (C)  COPYRIGHT IBM CORP. 2004 ALL RIGHTS RESERVED.
//* (C)  COPYRIGHT ROCKETSOFTWARE, INC. 2003 - 2004 ALL RIGHTS RESERVED.
//* US GOVERNMENT USERS RESTRICTED RIGHTS - USE, DUPLICATION, OR
//* DISCLOSURE RESTRICTED BY GSA ADP SCHEDULE CONTRACT WITH IBM CORP.

CONTROL NOMSG
FREE  FILE(AUZCLIST)                              
CONTROL MSG

ALLOC FILE(AUZCLIST) DATASET(’&CLISTLIB’) SHR REU

ALTLIB ACTIVATE APPLICATION(CLIST) FILE(AUZCLIST)

ISPEXEC SELECT CMD(AUZCLIST) NEWAPPL(AUZ) PASSLIB 

ALTLIB DEACTIVATE APPLICATION(CLIST)   
FREE FILE(AUZCLIST) 

AUZCLIST

AUZCLIST starts the SCLM Suite Administrator Workbench user interface.  The 
contents of the SCLM Suite Administrator Workbench member AUZCLIST are shown 
below.  You should note that this CLIST as distributed with the product is the most 
current version and may differ slightly from the listing presented here.

To customize member AUZCLIST,  alter the first lines of the CLIST as, for example:

Note:  When customizing the various parameters in a CLIST, you must ensure that the case of 
the values you enter must exactly match the case of the corresponding information in your 
Hierarchical File System (HFS) directory.  Thus, for example, if  the HFS directory where 
SCLM Suite Administrator Workbench resides is /usr/lpp/AUZ/v110/bin, you must ensure 
that your entry for the AUZ  CLIST SPATH shows usr, lpp, v110,  and bin in lower-case 
letters, and AUZ in upper-case letters. 
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PROC 0 HILEVEL(AUZ.WRK0110) XMLDSN(XML.HXML140.SIXMMOD1)  +
AUZNAME (AUZ140) SPATH (//usr/lpp/AUZ/v110/bin)

Set the variables HILEVEL, XMLDSN, AUZNAME, and SPATH  to the appropriate 
values.  

• HILEVEL is the high level qualifier that contains the AUZ datasets. 

• XMLDSN is the data set name of the load library containing the XML toolkit 
dynamic link libraries.

• AUZNAME is the name of the program to drive the ISPF interface. The  variable 
should be AUZ140 for installations using the XML toolkit V1R4M0 or AUZ160 for 
installations using the XML toolkit V1R6M0.

• SPATH is the path to the HFS system where scripts have been installed. (Note that 
the value in the parentheses requires a double slash (//) at the beginning of the 
variable.)

You need to ensure that any data set names after variable substitution do not exceed 
44 characters in length.

Contents of AUZCLIST:  
PROC 0 HILEVEL(HILEVEL) +                                               00010009
       XMLDSN(XMLDSN) +                                                 00020009
       AUZNAME(AUZ140) +                                                00030011
       SPATH(//usr/lpp/AUZ/v110/bin)                                    00040015
                                                                        00050005
//* LICENSED MATERIALS - PROPERTY OF IBM                                 00060008
//* 5655-L03                                                             00070008
//* (C) COPYRIGHT IBM CORP. 2004 ALL RIGHTS RESERVED.                    00080008
//* (C) COPYRIGHT ROCKET SOFTWARE, INC. 2003-2004 ALL RIGHTS RESERVED.   00090008
//* US GOVERNMENT USERS RESTRICTED RIGHTS - USE, DUPLICATION OR          00100008
//* DISCLOSURE RESTRICTED BY GSA ADP SCHEDULE CONTRACT WITH IBM CORP.    00110008
                                                                        00120000
//*CONTROL LIST CONLIST SYMLIST                                          00130000
                                                                        00140000
  ISPEXEC VGET (ZUSER ZPREFIX) ASIS                                     00150000
                                                                        00160000
  IF (&ZPREFIX ^= &ZUSER AND &ZPREFIX ^= ) THEN +                       00170003
    SET &TL = &STR(&ZPREFIX..&ZUSER)                                    00180002
  ELSE +                                                                00190000
    SET &TL = &ZUSER                                                    00200000
                                                                        00210000
  CONTROL NOMSG                                                         00220000
  IF &SYSDSN('&TL..&HILEVEL..ISPTLIB')^=OK THEN +                       00230002
    DO                                                                  00240000
     ALLOC F(XX) DA('&TL..&HILEVEL..ISPTLIB') SPACE(1 1) DIR(30) +      00250002
     CYLINDERS LRECL(80) BLKSIZE(800) DSORG(PO) RECFM(F B) NEW          00260000
    END                                                                 00270000
  FREE  FILE(XX)                                                        00280000
  CONTROL MSG                                                           00290000
                                                                        00300000
  ISPEXEC LIBDEF ISPMLIB  DATASET ID('&HILEVEL..SAUZMENU') UNCOND       00310000
  ISPEXEC LIBDEF ISPPLIB  DATASET ID('&HILEVEL..SAUZPENU') UNCOND       00320000
  ISPEXEC LIBDEF ISPSLIB  DATASET ID('&HILEVEL..SAUZSLIB') UNCOND       00330000
  ISPEXEC LIBDEF ISPLLIB  DATASET ID('&HILEVEL..SAUZLOAD' +             00340017
                                     '&XMLDSN') UNCOND                  00341017
  ISPEXEC LIBDEF ISPTLIB  DATASET ID('&TL..&HILEVEL..ISPTLIB') UNCOND   00350002
  ISPEXEC LIBDEF ISPTABL  DATASET ID('&TL..&HILEVEL..ISPTLIB') UNCOND   00360002
                                                                        00370000
  SET &SYSASIS = ON                                                     00380012
  &AUZNAME &SPATH                                                       00390011
                                                                        00400000
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Customizing the USS  components

The components of the SCLM Suite Administrator Workbench that operate under 
UNIX System Services are stored in the directories listed below. The path information 
is case-sensitive.

• <install-directory>/AUZ/v110/bin/

• <install-directory>/AUZ/v110/log/

• <install-directory>/AUZ/v110/rseserver603/

• <install-directory>/AUZ/v110/xsl/

Customizing IBM Workload Manager (WLM)

In order to prevent UNIX System Services scripts from taking over your system, it is 
recommended that you define a WLM Service Class for Unix System Services that has 
the same performance characteristics as low-priority batch.  However, you may 
choose to define your USS service class as having another priority,  depending on the 
characteristics of your enterprise’s installation. 

Customizing setup.sh and ispf.sh 

Customization may be required in the scripts setup.sh and ispf.sh. 

• setup.sh customization is  always required.  

• ispf.sh customization is required only if you are using the workstation client.

You can run a batch program to perform the customization.  If you would prefer to 
customize these two scripts by hand, you can follow the directions contained within 
the scripts themselves.

The statements that may need to be changed are:  

• export AUZ_MVS_REXX_EXECLIB="AUZ.WRK0110.SAUZEXEC"  

This statement contains the environment variables for the SCLM Suite 
Administrator Workbench.

• export AUZ_MVS_REXX_LOADLIB="AUZ.WRK0110.SAUZLOAD" 

• export AUZ_MVS_REXX_ISPSLIB="AUZ.WRK0110.ISPSLIB"

• export AUZ_HOME=/usr/lpp/AUZ/v110

• export AUZ_LOG=/usr/lpp/AUZ/v110/log

• export JAVA_HOME=/usr/lpp/java/IBM/J1.3

JAVA_HOME is required only if you will run the workstation part of SCLM Suite 
Administrator Workbench.   If Java™ is not installed in the usual directory, you 
must modify this statement to point to the installation directory for Java. Note 
that JAVA_HOME is not present in setup.sh.

• export XML_VERSION="V1R4M0"

Either XML Toolkit V1R4M0 or V1R6M0 may be used.  Ensure that your 
installation reflects the correct version of the XML Toolkit. 

Note:  If you have a choice of which version of the XML Toolkit to install, V1R4M0 
is preferred since  the TSO region size it requires is considerably smaller than that 
required by V1R6M0.

• export XML_HOME=/usr/lpp/ixm/IBM
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XML_HOME defines the location where the XML toolkit for z/OS was installed 
and should be modified as appropriate for your installation.

Batch program to customize setup.sh and ispf.sh

If you want to customize setup.sh and ispf.sh using a batch program provided by 
SCLM Suite Administrator Workbench, follow these instructions.  Alternatively, 
should you wish to manually customize setup.sh and ispf.sh, follow the instructions 
provided with those scripts.

Note:  In order to run this batch customization, the user ID under which this program 
is run must have root authority.

Batch customization program contents

//AUZCUSTJ  JOB 01,
//           'NAME',
//           CLASS=A,
//           NOTIFY=&SYSUID
//*
//*
//* Licensed Materials - Property of IBM
//* 5655-L03
//* (c) Copyright IBM Corp. 2004 All Rights Reserved.
//* (c) Copyright Rocket Software, Inc. 2003-2004 All Rights Reserved.
//* US Government Users Restricted Rights - Use, duplication or
//* disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
//*
//*
//*  This JOB customizes setup.sh and ispf.sh
//*
//*  Set the customizable parameters:
//*
//*  For the SETUP step, the following STDENV sysin parameters
//*
//*     AUZ_MVS_REXX_EXECLIB=<sauzexec dsn>
//*        Fully qualified SAUZEXEC dataset name
//*
//*     AUZ_MVS_REXX_LOADLIB=<sauzload dsn>
//*        Fully qualified SAUZLOAD dataset name
//*
//*     AUZ_MVS_ISPSLIB=<ispslib dsn>
//*        Fully qualified SAUZSLIB dataset name
//*
//*     AUZ_JAVA_HOME=<java base directory>
//*        Installation directory for JAVA
//*
//*     AUZ_HOME=<product base directory>
//*        Installation directory for AUZ
//*
//*     AUZ_LOG=<product log directory>
//*        Directory for AUZ log
//*
//*     AUZ_XML_VERSION=V1R4M0 or V1R6M0
//*        XML Toolkit version installed
//*
//*     AUZ_XML14_HOME=<XML Toolkit base directory>
//*        XML Toolkit base directory if using XML Toolkit 1.4
//*
//*     AUZ_XML16_HOME=<XML Toolkit base directory>
//*        XML Toolkit base directory if using XML Toolkit 1.6
//*
//*
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//*  For the ISPF step, the following STDENV sysin parameters
//*
//*     AUZ_HOME=<product base directory>
//*        Installation directory for AUZ
//*
//*     AUZ_UNIT=<dasd unit>
//*        Unit to allocate ISPF files on
//*
//*     AUZ_ISPMLIB=<list of datasets>
//*        List of dataset names separated by colons
//*
//*     AUZ_ISPPLIB=<list of datasets>
//*        List of dataset names separated by colons
//*
//*     AUZ_ISPTLIB=<list of datasets>
//*        List of dataset names separated by colons
//*
//*     AUZ_ISPSLIB=<list of datasets>
//*        List of dataset names separated by colons
//*
//*     AUZ_ISPLLIB=<list of datasets>
//*        List of dataset names separated by colons
//*
//*     AUZ_SYSEXEC=<list of datasets>
//*        List of dataset names separated by colons
//*
//*
//*  Note: This file contains both lower and upper case characters.
//*        The case of the text must be preserved.
//*        Also, the file must always be saved NONUM and some lines
//*        may have the backslash (\) character in column 80.
//*        These must also be preserved.
//*
//*
//SETUP    EXEC PGM=BPXBATCH,REGION=0M,
//          PARM='SH cd ${AUZ_HOME}/bin;./setup_customizer.rexx'
//STDENV   DD  *
AUZ_MVS_REXX_EXECLIB=AUZ.WRK0110.SAUZEXEC
AUZ_MVS_REXX_LOADLIB=AUZ.WRK0110.SAUZLOAD
AUZ_MVS_ISPSLIB=AUZ.WRK0110.SAUZSLIB
AUZ_JAVA_HOME=/usr/lpp/java/IBM/J1.3
AUZ_HOME=/usr/lpp/AUZ/v110
AUZ_LOG=/usr/lpp/AUZ/v110/log
AUZ_XML_VERSION=V1R4M0
AUZ_XML14_HOME=/usr/lpp/ixm/IBM
AUZ_XML16_HOME=/usr/lpp/ixm/IBM
//*
//STDIN    DD  DUMMY
//STDOUT   DD  PATH='/tmp/&SYSUID..out',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OTRUNC)
//STDERR   DD  PATH='/tmp/&SYSUID..err',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OTRUNC)
//SYSPRINT DD  SYSOUT=*
//*
//ISPF     EXEC PGM=BPXBATCH,REGION=0M,
//          PARM='SH cd ${AUZ_HOME}/bin;./ispf_customizer.rexx'
//STDENV   DD  *
AUZ_HOME=/usr/lpp/AUZ/v110
AUZ_UNIT=SYSALLDA
AUZ_ISPPLIB=SYS1.SBPXPENU:ISP.SISPPENU
AUZ_ISPMLIB=SYS1.SBPXMENU:ISP.SISPMENU
AUZ_ISPTLIB=ISP.SISPTENU
AUZ_ISPSLIB=ISP.SISPSENU
AUZ_ISPLLIB=SYS1.LINKLIB:ISP.SISPLOAD
AUZ_SYSEXEC=SYS1.SBPXEXEC
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//*
//STDIN    DD  DUMMY
//STDOUT   DD  PATH='/tmp/&SYSUID..out',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OAPPEND)
//STDERR   DD  PATH='/tmp/&SYSUID..err',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OAPPEND)
//SYSPRINT DD  SYSOUT=*
//*
//REPORT   EXEC PGM=IKJEFT01
//SYSTSPRT DD  SYSOUT=*
//HFSOUT   DD  PATH='/tmp/&SYSUID..out',
//           PATHDISP=(DELETE,DELETE)
//HFSERR   DD  PATH='/tmp/&SYSUID..err',
//           PATHDISP=(DELETE,DELETE)
//STDOUTL  DD  SYSOUT=*,
//           DCB=(RECFM=VB,LRECL=1020,BLKSIZE=1024)
//STDERRL  DD  SYSOUT=*,
//           DCB=(RECFM=VB,LRECL=1020,BLKSIZE=1024)
//SYSPRINT DD  SYSOUT=*
//SYSTSIN  DD  *
  OCOPY INDD(HFSOUT) OUTDD(STDOUTL)
  OCOPY INDD(HFSERR) OUTDD(STDERRL)
//

Customizing setup.sh 

If you prefer to customize setup.sh by hand, you can do so by following the 
instructions imbedded in the script.  Alternatively, you can run a program to perform 
this customization.  See “Batch program to customize setup.sh and ispf.sh” on page 
18.   A listing of setup.sh is included here for your reference.  You should note that the 
script as distributed with the product is the most current version and may differ 
slightly from the listings presented here. 

Content of setup.sh

#!/bin/sh
#
#   IBM SCLM Suite Admininistrator Workbench
#   ISPF USS Environment set up script
#
#   Usage:   . setup.sh
#
#   Licensed Materials - Property of IBM
#   5655-L03
#   (c) Copyright IBM Corp. 2004  All Rights Reserved.
#   (c) Copyright Rocket Software, Inc. 2003 - 2004  All Rights Reserved.
#   US Government Users Restricted Rights - Use, duplication or 
#   Disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
#
#
#   Environment variables for SCLM Suite Administrator Workbench
#

export AUZ_MVS_REXX_EXECLIB="AUZ.WRK0110.SAUZEXEC"
export AUZ_MVS_REXX_LOADLIB="AUZ.WRK0110.SAUZLOAD"
export AUZ_MVS_ISPSLIB="AUZ.WRK0110.SAUZSLIB"
export AUZ_HOME=/usr/lpp/AUZ/v110
export AUZ_LOG=/usr/lpp/AUZ/v110/log
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#################################################
# Required only if running Windows or Unix client
export JAVA_HOME=/usr/lpp/java/IBM/J1.3
#################################################

export XML_VERSION=V1R4M0

if [ ${XML_VERSION} = "V1R4M0" ]
then
{
    export XML_HOME=/usr/lpp/ixm/IBM
    export XML4C=xml4c-4_0
    export XSLT4C=LotusXSL-C_1_3
    export JCL2ARCHDEF=jcl2archdef140
    export JCL2LDML=jcl2ldml140
}
fi
if [ ${XML_VERSION} = "V1R6M0" ]
then
{
    export XML_HOME=/usr/lpp/ixm/IBM
    export XML4C=xml4c-5_2
    export XSLT4C=xslt4c-1_5
    export JCL2ARCHDEF=jcl2archdef160
    export JCL2LDML=jcl2ldml160
}
fi
SHELL=/bin/sh
TZ=EST5EDT
LANG=C
export PATH=$PATH:/bin:.:${AUZ_HOME}/bin:${XML_HOME}/${XSLT4C}/bin:/usr/sbin
export ICU_DATA=${XML_HOME}/${XML4C}/lib
export LIBPATH=${XML_HOME}/${XSLT4C}/lib:${XML_HOME}/${XML4C}/lib:${LIBPATH}
export STEPLIB=${AUZ_MVS_REXX_LOADLIB}:none

Customizing ispf.sh

It may also be necessary to customize the script ispf.sh for your installation.  If you 
prefer to customize ispf.sh by hand, you can do so by following the instructions 
imbedded in the script.  Alternatively, you can run a program to perform this 
customization.  See “Batch program to customize setup.sh and ispf.sh” on page 18. 
You should note that this script as distributed with the product is the most current 
version and may differ slightly from the listing presented here. 

If you are performing a manual customization, the statements that should be 
reviewed and possibly changed are:

• export TSOALLOC=ispprof:ispplib:ispmlib:isptlib:ispllib:ispslib:\
isptabl:isplog:sysexec

• export isptabl="alloc new unit (sysvio) space (1,1) cyl dir(5) \
recfm (f, b) lrecl (80) blksize (3120)" 

• export ispplib=SYS1.SBPXPENU:ISP.SISPPENU

• export ispmlib=SYS1.SBPXMENU:ISP.SISPMENU

• export isptlib=ISP.SISPTENU

• export ispslib=ISP.SISPSENU

• export ispllib=SYS1.LINKLIB:ISP.SISPLOAD

• export sysexec=SYS1.SBPXEXEC:${AUZ_MVS_REXX_EXECLIB}

Note:  By default, the ISPF log is not written to the spool.  If you want to see the log in 
the spool then you must:
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• Comment out the line: export isplog="alloc dummy"    

• Uncomment the line: #export isplog="alloc sysout(a) recfm(v,a) lrecl(125) 
blksize(129)"   

Content of ispf.sh

#!/bin/sh
# Licensed Materials - Property of IBM
# 5655-L03
# (c) Copyright IBM Corp. 2004  All Rights Reserved.
# (c) Copyright Rocket Software, Inc. 2003 - 2004  All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or
# Disclosure restricted by GSA ADP Schedule Contract with
# IBM Corp

# Assign the DD names to allocate                                       
#                                                                       
#
export TSOALLOC=ispprof:ispplib:ispmlib:isptlib:ispllib:ispslib:\
isptabl:isplog:sysexec                                                  
#                                                                       
# Allocate an empty, temporary ISPF profile data set                    
#                                                                       
export ispprof="alloc new unit(sysallda) space(1,1) cyl dir(5) \
recfm(f,b) lrecl(80) blksize(3120)"                                     
#                                                                       
# Allocate an empty, temporary ISPF table data set                      
#                                                                       
export isptabl="alloc new unit(sysallda) space(1,1) cyl dir(5) \
recfm(f,b) lrecl(80) blksize(3120)"                                     
#                                                                       
# Allocate the ISPF log to DUMMY
#                                                                       
#export isplog="alloc sysout(a) recfm(v,a) lrecl(125) blksize(129)"      
export isplog="alloc dummy"      
#                                                                       
# Allocate the OpenMVS and ISPF panel data sets to ISPPLIB              
#                                                                       
export ispplib=SYS1.SBPXPENU:ISP.SISPPENU                               
#                                                            
# Allocate the OpenMVS and ISPF message data sets to ISPMLIB            
#                                                                       
export ispmlib=SYS1.SBPXMENU:ISP.SISPMENU                               
#                                                                       
# Allocate the ISPF table data set to ISPTLIB                           
#                                                                       
export isptlib=ISP.SISPTENU                                             
export ispslib=ISP.SISPSENU                                             
#                                                                       
# Allocate any load library to ISPLLIB if ISPF is in LINKLIST/LPA       
#                                                                       
export ispllib=SYS1.LINKLIB:ISP.SISPLOAD 
#                                                                       
# Allocate the OpenMVS EXEC data set to SYSEXEC                         
#                                                                       
export sysexec=SYS1.SBPXEXEC:${AUZ_MVS_REXX_EXECLIB}

Additional USS customization requirements

In addition to the foregoing, you must verify that the following installation 
requirements are met:

• /tmp must be accessible to and writable by all users
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• /usr/lpp/AUZ/v110/log must be writable by all users.  If the log directory is 
relocated, the relocated directory must be writable by all users.

• /usr/lpp/AUZ/v110/bin/auzauth

— is of size 0

— is executable

— has the t bit set when viewed with ’ls -la/usr/lpp/AUZ/v110/bin/auzauth’.

   

Customizing PARMLIB

Make the following PARMLIB changes:

• CEE.SCEERUN must be link-listed

• AUZ.SAUZLOAD must be APF-authorized

Customizing TCP/IP to invoke REXEC

To configure  and activate OMVS REXEC, you must perform the following tasks:

1. Deactivate MVSRXSERVE from ports 512 and 514 and relocate to alternate ports, 
for example, 1512 and 1514.  Guidance on setting up orexecd can be found in  the 
most recent versions of:

• z/OS Communications Server: IP Configuration Guide, the chapter entitled 
"Remote Execution," as well as in "Appendix A: Setting up the inetd 
configuration file."   

• z/OS Communications Server: IP Configuration Reference, the chapter entitled 
"Remote execution server."  

You should also review any informational APARS on this topic.

2. Modify TCPIP.DATA to AUTOLOG INETD.  An example follows: 

AUTOLOG 5
     FTPD JOBNAME FTPD1 L; FTP Server
     INETD JOBNAME INETD1 ; INETD Server
     OSNMPD ; SNMP Agent Server
     SNMPQE ; SNMP Client
ENDAUTOLOG

3. Reserve ports 512 and 513 to INETD1 as follows:

    512 TCP INETD1 ; OE RLOGIN SERVER 
    513 TCP INETD1 ; OE RLOGIN SERVER 

The user under which INETD1 runs must have read access to the BPX.DAEMON 
profile in the FACILITY class.

4. Create a started task to run in the INETD daemon (inetd) under BPXBATCH. An 
example follows:

//INETD PROC 
//INETD EXEC PGM=BPXBATCH,REGION=30M,TIME=NOLIMIT, 
//* PARM=('PGM /usr/sbin/inetd /etc/inetd.conf') 
// PARM=('PGM /usr/sbin/inetd') 
//STDERR DD PATH='/etc/log',PATHOPTS=(OWRONLY,OCREAT,OAPPEND), 
// PATHMODE=(SIRUSR,SIWUSR,SIRGRP,SIWGRP) 
//SYSPRINT DD SYSOUT=*,DCB=(RECFM=F,LRECL=132,BLKSIZE=132) 
//SYSIN DD DUMMY 
//SYSERR DD SYSOUT=* 
//SYSOUT DD SYSOUT=*,DCB=(RECFM=F,LRECL=132,BLKSIZE=132) 
//CEEDUMP DD SYSOUT=* 
//STDENV DD DSN=TCPIP.TCPPARMS(INETDENV),DISP=SHR 
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5. Populate /etc/services with valid values including the values for exec and 
login as shown below:

# 
# UNIX specific services 
# 
exec 512/tcp 
biff 512/udp comsat 
login 513/tcp 
who 513/udp whod 

Note:  A sample copy of  /etc/services is provided in /usr/lpp/tcpip/samples. 

6. Modify /etc/inetd.conf so that the lines for exec and login read as follows:

login stream tcp nowait OMVSKERN /usr/sbin/rlogind rlogind -m 
exec stream tcp nowait OMVSKERN /usr/sbin/orexecd orexecd -l -v 

The format of the inetd.conf file is specified in the z/OS UNIX System Services 
Command Reference, the chapter entitled "INETD inetd daemon -- Provide Internet 
Service Management." 

Customizing RACF

The following changes are required to be made to RACF to run SCLM Suite 
Administrator Workbench. 

Specifying TSO(HOLDCLASS)  under RACF

SCLM Suite Administrator Workbench requires that  users have a HOLDCLASS 
specified in their TSO segment in order to create language definitions and architecture 
definitions from JCL.  Thus, the system’s security administrator  must take  action to 
update each user’s RACF profile.  One of the following methods can be used:

• When adding  or changing  a user ID:

1. Access RACF  Option 4 USER PROFILES AND YOUR OWN PASSWORD

2. On the second (ADD AN ID)  or third (CHANGE AN ID) RACF panel,  type YES on 
the line 

TO ADD OPTIONAL INFORMATION, ENTER YES ===>

3. Scroll to and select   

___TSO PARAMETERS

4. Scroll to the following and type an appropriate class

Change Hold Class  (HOLDCLASS__ 1—9, A—Z, or blank

• Alternatively,  from the RACF command line, enter

ALU xxxxxxxxTSO (HOLDCLASS(C))

where xxxxxxxx is the user ID to be updated and c is an appropriate class.

Specifying TSO region size under RACF

SCLM Suite Administrator Workbench requires that  users specify a maximum size 
value for their TSO region of at least

• 20000 if using XML toolkit V1R4, or

• 60000 if using XML toolkit V1R6

Because the amount of memory below the line may be limited, a value of 20000 or 
greater is recommended. The system’s security administrator must take  action to 
update each user’s RACF profile.  One of the following methods can be used:
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• When adding  or changing  a user ID:

1. Access RACF  Option 4 USER PROFILES AND YOUR OWN PASSWORD

2. On the second (ADD AN ID)  or third (CHANGE AN ID) RACF panel,  type YES on 
the line 

TO ADD OPTIONAL INFORMATION, ENTER YES ===>

3. Scroll to and select ___TSO PARAMETERS   

4. Scroll to the following and type an appropriate class

Change Maximum Region Size (MAXSIZE)______0—2096128

• Alternatively,  from the RACF command line, enter

ALU xxxxxxxxTSO (MAXSIZE(nnnnn))

where xxxxxxxx is the userID to be updated and nnnnn is 20000 when using XML 
toolkit V1R4 or 60000 when using XML toolkit V1R6 .

Modifying a user’s OMVS segment

Each user that is to use the SCLM Suite Administrator Workbench must have a USS 
OMVS segment that specifies:

• A maximum process size set to 0

• A valid home directory

• A valid shell

• A valid non-zero uid. The user id must be unique for each user.

• RACF SPECIAL authority, if and only if that user will administer Enhanced 
Access Control for SCLM.

Customization required to obtain and view Enhanced Access Control for 
SCLM violations

If you are using Enhanced Access Control for SCLM and you want to be able to list 
violations, the full SMP/E life cycle for the Enhanced Access Control for SCLM 
product must be completed.  Module HSS.AHSSLOAD(HSSGDBUF), a component of 
Enhanced Access Control for SCLM that is used to obtain violations, must be 
available to the host components of SCLM Suite Administrator Workbench.  This 
module can be found in HSS.AHSSLOAD after you have performed an SMP/E 
ACCEPT on Enhanced Access Control for SCLM.  Either copy this module to 
AUZ.SAUZLOAD or to another link-listed library, or place HSS.AHSSLOAD in the 
link list. 

Starting an SCLM Suite Administrator Workbench host session

If you intend to use only the host component of the  SCLM Suite Administrator 
Workbench, you can now begin a host session as described in Chapter 6, “Starting an 
SCLM Suite Administrator Workbench Session,” on page 39.  
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Chapter 4. The Installation Verification Program

An installation verification program (IVP) that can be run from USS, TSO-E, and batch  
is shipped with SCLM Suite Administrator Workbench.    

Running the installation verification program

To  run the IVP in batch mode, you will need to perform the following customization 
on this file:

• The AUZ installation path must be specified on the BPXBATCH PARM line.

• You will need to review the STDENV parameters as follows:

— TESTGUI=Y|N will run a communcations layer test of workstation connectivity. 
Specify N if you are using only ISPF.

— Use TESTHLQ=<hlq>  to set the valid high level qualifier for test project use 
(single level HLQ only).

— Use SISPMACS=<sispmacs dsn> to set the SISPMACS data set (normally 
ISP.SISPMACS).

— Use PSWDDSN=<password dsn> to specify a SAM data set name that contains 
your MVS password on line 1 in free format.  Ensure that it is RACF-
protected.  This step is not required if you specified TESTGUI=N.

Note:  This file contains both lower and upper case characters. The case of the text 
must be preserved. Also, the file must always be saved NONUM and some lines may 
have the backslash (\) character in column 80.  These must also be preserved. 

//AUZIVPJ  JOB 01,
//           'NAME',
//           CLASS=A,
//           NOTIFY=&SYSUID
//*
//* Licensed Materials - Property of IBM
//* 5655-L03
//* (c) Copyright IBM Corp. 2004 All Rights Reserved.
//* (c) Copyright Rocket Software, Inc. 2003-2004 All Rights Reserved.
//* US Government Users Restricted Rights - Use, duplication or
//* disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
//*
//*
//*  This JOB runs the AUZ Installation Verification Program (IVP).
//*
//*
//*  STDENV sysin parameters required:
//*
//*     TESTGUI=Y|N will run a communcations layer test of workstation
//*                 connectivity (specify N if only using ISPF).
//*
//*     TESTHLQ=<hlq> is used to set the valid high level qualifier for
//*                   test project use (single level HLQ only).
//*
//*     SISPMACS=<sispmacs dsn> is used to set the SISPMACS dataset
//*              (normally ISP.SISPMACS)
//*
//*     PSWDDSN=<password dsn> is used to specify a SAM dataset name
//*             that contains your MVS password on line 1 (free format)
//*             and should be RACF protected. Not needed if TESTGUI=N.
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//*
//*  Note: This file contains both lower and upper case characters.
//*        The case of the text must be preserved.
//*        Also, the file must always be saved NONUM and some lines
//*        may have the backslash (\) character in column 80.
//*        These must also be preserved.
//*
//*
//IVP      EXEC PGM=BPXBATCH,REGION=0M,
//            PARM='SH cd /usr/lpp/AUZ/v110/bin;./ivp.rexx'
//STDENV   DD  *
TESTGUI=Y
PSWDDSN=DSN
TESTHLQ=TEST
SISPMACS=ISP.SISPMACS
//*
//STDIN    DD  DUMMY
//STDOUT   DD  PATH='/tmp/&SYSUID..out',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OTRUNC)
//STDERR   DD  PATH='/tmp/&SYSUID..err',
//           PATHMODE=SIRWXU,
//           PATHOPTS=(OWRONLY,OCREAT,OTRUNC)
//SYSPRINT DD  SYSOUT=*
//*
//REPORT   EXEC PGM=IKJEFT01
//SYSTSPRT DD  SYSOUT=*
//HFSOUT   DD  PATH='/tmp/&SYSUID..out',
//           PATHDISP=(DELETE,DELETE)
//HFSERR   DD  PATH='/tmp/&SYSUID..err',
//           PATHDISP=(DELETE,DELETE)
//STDOUTL  DD  SYSOUT=*,
//           DCB=(RECFM=VB,LRECL=1020,BLKSIZE=1024)
//STDERRL  DD  SYSOUT=*,
//           DCB=(RECFM=VB,LRECL=1020,BLKSIZE=1024)
//SYSPRINT DD  SYSOUT=*
//SYSTSIN  DD  *
  OCOPY INDD(HFSOUT) OUTDD(STDOUTL)
  OCOPY INDD(HFSERR) OUTDD(STDERRL)
//
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Chapter 5. Installing and Configuring the Workstation Client

Once SCLM Suite Administrator Workbench has been installed and configured on the 
host, you will want to download, install, and configure  the workstation client.  Note 
that, because enterprises vary in their installation requirements, the configuration and 
customization information in this chapter may not be an exhaustive list of the changes 
required to be made to your installation. 

Installing the client

To begin the installation process for the client, access your host system to locate the 
PDS or PDS-E that contains the installer for your client environment.  The table that 
follows lists the names of the data sets that contain the installers, the names of the 
installers,  and the environments they support.  In the table, <hilev> identifies the 
high-level qualifier for the data set.

   

 

Each of the data sets above can be installed individually.  You may install as many as 
you need.  If you want to run the GUI client on a platform for which the installation 
data set is not present, you will need to contact your site’s systems programmer who 
is responsible for installation. 

Note:  SCLM Suite Administrator Workbench requires that it be installed into 
WebSphere Studio WorkBench Version 2.1.1 or later.

 Installing on Windows: If you are running on Windows:

1. Download the installation package SAUZGUIW to your workstation by 
performing a binary transfer using FTP or an equivalent transfer mechanism. 
Place the installation package in a Temp folder. 

2. Open the Temp folder.

3. Highlight auzwin32.  Rename this file to auzwin32.exe. 

4. Click auzwin32.exe to invoke the InstallShield MultiPlatform Installer.

Installing on a UNIX®-based system:  If you are running on a UNIX or Linux system, 
you must be running under the X Windows system. 

1. Run xterm or xcolor  to verify that your X server is operational.

2. Verify that the  DISPLAY environment variable is set to the location where you 
will monitor the application.  The statement to do so is:

Table 1. Installation data sets and the platforms to which they apply

Installation data set  name Installer name Platform to which it applies

<hilev>.SAUZGUIW AUZWIN32 Windows® 2000
Windows XP

<hilev>.SAUZGUIA AUZAIX5L AIX 5L™

<hilev>.SAUZGUIS AUZSOL8 Solaris 8

<hilev>.SAUZGUIH AUZHPUX HPUX

<hilev>.SAUZGUIK AUZLNGTK Linux GTK
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"export DISPLAY=<display-location host name>:0"

3. Verify that  <display-location host name> can accept X connections by running  xhost 
there.  Note that this step is not necessary if the system represented by <display-
location host name> is the same host system on which you are installing the client; 
for example, "xhost +".

4. Change directories (cd) to a work directory that must have sufficient space to  
store an 800MB temporary file.  Download the installation package appropriate to 
your client workstation by performing a binary transfer using FTP or an 
equivalent transfer mechanism. Place the installation package in a Temp folder.  
The example below does so for an AIX system.

> "ftp <USS host>" and authenticate
> "binary"
> "lcd <local temp directory>"
> "cd ’AUZ.SAUZGUIA’"
> "get AUZAIX5L"
> "quit" or "bye" to exit

5. Once you have performed the binary FTP to move the appropriate installer (see 
Table 1 on page 29) to your client workstation, rename the downloaded file to a 
valid executable name for your platform; for example AUZAIX5L.bin for the AIX 
environment or AUXLNX.bin for Linux.

6. Run the installer to  invoke the InstallShield MultiPlatform Installer.  The example 
below performs this function for AIX. The statement chmod +x *.bin sets the 
execute permissions.

"cd <temp directory>"
"mv AUXAIX5L AUZAIX5l.bin"
"chmod +x *.bin"
"./AUZAIX5L.bin"

The InstallShield MultiPlatform Installer

While the InstallShield MultiPlatform Installer  is executing,  your screen will be blank 
for some period of time.  This is normal.  Please wait until the InstallShield Wizard 
appears, when you will be requested to take additional actions.

As the installation progresses, you will be asked where you would like to install 
SCLM Suite Administrator Workbench.  The default directory is c:/program 
files/IBM/SCLM Admin Workbench. However, you may choose another directory if you 
wish. 

This completes the installation. 

Note:  If the installation process fails, the SCLM Suite Administrator Workbench 
installer may be unable to clean up its swap files. These files are usually in a directory 
that begins with the letters is.  The files can be found in your temporary directory or in 
the directory that is specified with the command line parameter ’is:tempdir: 
"/my/swap/directory"’. These directories take up space and may hinder future 
installations.  You should, therefore, backup and then safely remove these directories.  

Temporary disk space for the installer

The SCLM Suite Administrator Workbench installation program needs a temporary 
area on disk with a sufficient amount of space.  During the installation process, you 
may receive the following message:

Error Writing File. There may not be enough temporary disk space. 
Try using -is:tempdir to use a temporary directory on a partition with more disk space.
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If this message is displayed, specify a temporary area as follows:

mmmmmmmm -is:tempdir "directory-path"

where:

mmmmmmmm
is the name of an installer such as AUZWIN32.exe or AUZLNGTK.bin.

directory-path
represents the path to the temporary area on disk; for example, "/tmp/AUZ".

Uninstalling SCLM Suite Administrator Workbench

To uninstall SCLM Suite Administrator Workbench, invoke the Uninstall Wizard as 
follows:

1. Select Start > Programs > IBM SCLM Suite Administrator Workbench > 
Uninstall >Uninstall SCLM Administrator Workbench. This invokes the 
Wizard.

2. The Uninstall Wizard displays. You can choose to uninstall only SCLM Suite 
Administrator Workbench or you can also uninstall WebSphere Studio 
Workbench.  Once you have selected one or both of these products to be 
uninstalled, clicking Next starts the uninstall process.

3. The Uninstall Wizard confirms the uninstall of the product or products.  When 
you click Next on this panel, and if you have chosen to uninstal WebSphere 
Studio Workbench in addition to SCLM Suite Administrator Workbench, the 
Uninstall Wizard requests that you access the directory where WebSphere Studio 
Workbench had been installed and manually delete your .config and workspace 
folders.  This step is not required if you are removing only  SCLM Suite 
Administrator Workbench.

Installing the SCLM Suite Administrator Workbench client into 
an existing workspace

If you have installed  the  SCLM Suite Administrator Workbench client and choose to 
reinstall it into an existing workspace, you must first uninstall the previous 
installation of the product using the Uninstall Wizard as described in  “Uninstalling 
SCLM Suite Administrator Workbench”. SCLM Suite Administrator Workbench 
preserves workstation client preferences and Remote Systems Explorer (RSE) 
configuration specifications  during the uninstallation/reinstallation process.

Configuring the client component

Follow these steps to configure your workstation client.  Once you have configured 
your client component, it will be unnecessary to repeat these steps unless you want to 
configure additional host connections.

1. From the task bar, select Start > Programs and then IBM SCLM Suite 
Administrator Workbench to open a session.

2. When the initial SCLM Suite Administrator Workbench panel opens, select the 
SCLM Suite Administrator Workbench perspective by:

• Clicking the SCLM Perspective icon at the left of the screen, or

• Clicking the Open a Perspective icon  at the left of the screen and selecting 
SCLM Admin Workbench, or

• From the Window pulldown, select Open  Perspective  > SCLM Admin 
Workbench.
 Chapter 5.   Installing and Configuring the Workstation Client  31



 

3. Configure a connection to the host system by expanding the New Connection in 
the Remote Systems View in the left-hand pane of your workspace. From the list 
of host systems, click on the type of host you want to configure, in this case, z/OS.  

SCLM Suite Administrator Workbench presents you with the New Remote 
System Connection dialog.  Fill out the  fields on this panel.  You may have to 
obtain the information specific to your site from your systems programmer. 
Information on completing the dialog can also be found in the Remote Systems 
Explorer User’s Guide that is part of the Eclipse online Help.

• Parent Profile. Select the appropriate profile from the drop-down list.

• Connection Name. Enter the information required to create a connection to 
the host system where the SCLM project you want to administer resides.

• System Type. If this entry field is included on the dialog, select  the 
appropriate system type from the drop-down list. (This field will not be 
present  if you selected the host type in the Remote System View.)

• Host Name. Enter the host name. 

• Description.  Enter a description for this host connection

• Verify Host Name checkbox.  Place a check in this box if you want to verify 
the host name.  SCLM Suite Administrator Workbench will confirm that this 
host is available to be connected to. 

4. When you have completed the New Remote System Connection dialog, click 
Finish.

5. Configure the Files subsystem Server Launcher Settings page:

a. Right-click Files  in the Remote Systems View Navigation Tree in the left pane 
of  your workspace and, from the pop-up menu, select Properties.  SCLM 
Suite Administrator Workbench displays the Properties for Files dialog.

b. On the Properties for Files dialog, from the Navigator, select Server Launcher 
Settings.

c.  To indicate how the remote server should be launched, select REXEC.

d. Enter the path to the remote server.  The path information is case-sensitive. 
The format of the path is 

/<install-directory>/AUZ/v110/rseserver603

 where the recommended installation directory is /usr/lpp. 

e. Enter the name of the Server Launcher script by overtyping the default text 
server.unix with the text server.zseries.

f. Enter the Port number for the port on the host system to which the client is to 
connect.  The standard REXEC default is 512.  If your installation will use a 
different value, you may need to obtain this value from your systems 
programmer.

g. Click OK to complete this dialog. 

 

Setting preferences for SCLM Suite Administrator Workbench

Use the Preferences page to:

• Determine whether your SCLM Suite Administrator Workbench jobs will run in 
batch or in the foreground 

• Set default job card information

• Set default DCB values for the default Types in your profile. 
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•  Set a data set search filter.  

 To access the Preferences page, from the Window pulldown, click  Preferences.  In the 
Navigation Tree that is presented to you, click SCLM Admin Workbench.  After you 
have specified or modified your preferences, click OK to return to your project.

Running jobs in batch or foreground

To set your preference for running jobs, access Preferences as described above.  Click 
the appropriate radio button. Then enter the JCL needed to run your jobs in the text 
boxes provided. When you have completed your entries on this page, click Apply.  At 
any time, you can return to this page to modify your selection or to restore the 
product’s default settings.

Setting a data set search filter

from the Window pulldown, click  Preferences.  In the Navigation Tree that is 
presented to you, click SCLM Admin Workbench.  In the text box provided, specify a 
value to be used by the project editor as the default data set search filter if you do not 
provide a filter in a text field.  The default data set search filter is AUZ.

For example, if you are using the Default Data Set Dialog and press the Browse button 
without entering a data set name or filter in the text field, SCLM Suite Administrator 
Workbench will use the value you have entered here as the filter.

Defining default Types and setting their DCB values

SCLM Suite Administrator Workbench provides a number of  fully-defined default 
Types which you can choose to include in your project as is.  You can use the Default 
Types Preference page to modify the Type definition for these types or to define new 
Types.  You may already have worked with the product’s default Types when 
customizing the workstation client. To access the Default Types Preference page, 
expand the SCLM Admin Workbench item in the Preferences Navigator Tree by 
selecting the following from the Window pulldown: Window > Preferences > SCLM 
Admin Workbench > Default Types Preference Page.  

To  add a default Type to your project, on the Preferences page, select the Type to be 
added from the list of default Types and click the Add button.    To edit an existing 
default Type, click the Edit button.  SCLM Suite Administrator Workbench displays 
the  Type Dialog on which you can specify or edit the selected Type information:

1. A name of up to 8 characters and a description for the Type. (If you are editing an 
existing Type, its name is filled in this field.)

2. The average number of records contained in the top-level data set of this Type. 
This mandatory value, together with the number of members value and the DCB, 
is used to calculate the space required for the PDS or PDS-E at the top of the 
promotion tree.

3. The number of members contained in the top-level Type data set. This mandatory 
value, together with the average number of records value and the DCB, is used to 
calculate the space required for the PDS or PDS-E at the top of the promotion tree.

4. An extended Type name of up to 8 characters that can be used as an alternate 
Type if it is necessary to resolve include dependencies.

If  a Type has been defined as using package backout:

1. Specify a number in the Reuse Days text box to indicate the number of days for 
which a backout can be performed. This field can only be specified if you check 
ISA Pack for this Type.
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2. Click the Pkg Backup check box to specify that this Type of file is to be backed up 
during a promote.

3. Click the ISA Pack check box to specify that this architecture definition will be 
used to drive the packages that are permitted to be backed out.  This flag can be 
specified only for architecture definition  (ARCHDEF) Types.

4. Click the Packfile box to specify that this Type is to hold the package detail files.

Specify the following default DCB information for the Type:

• The default DCB record format. Valid formats are FB, FBA, VB, VBA, FBM, VBM, 
or U. 

• The default DCB block size. Valid value is an integer from 32 — 32760

• The default DCB logical record length. Valid value is an integer from 32 — 32756. 

Note:  When you add a new Type to your project, you should ensure that:

— If RECFM=U, LRECL must be equal to 0. BLKSIZE must not be equal to 0, 
and must be less than or equal to 32760.

— If RECFM=VBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be greater than LRECL + 4 and less than or equal to 32760.

— If RECFM=FBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be an exact multiple of LRECL and less than or equal to 32760.

When you have completed your entries on this page, click OK.  At any time, you can 
return to this page to modify your entries, to remove a default Type from your profile, 
or to restore the product’s default settings.

Setting Remote Systems Explorer preferences

To set your Remote Systems Explorer preferences, select Window > Preferences > 
Remote Systems. 

• Optionally, check Show "New Connection" prompt in Remote Systems tree

• Checking Reopen Remote Systems View to previous state is used to reconnect 
open sessions, but can take a long time to complete. If you just want to work with 
one specific connection, it is recommended that you leave this box unchecked.  
This gives you additional flexibility in the time required to initiate a session.

For information about Remote Systems Explorer, see the Remote Systems Explorer 
User’s Guide that is part of the Eclipse online Help.

Note:   A new Preferences page in RSE 6.0.3 permits you to control file cache size and 
clear the cache. If you do so while you have an open project, you will impact your 
ability to correctly save your project. Thus, you must not clear the cache while you 
have projects open in SCLM Suite Administrator Workbench. 

Setting Enhanced Access Control preferences

Information about setting preferences for Enhanced Access Control for SCLM can be 
found in the SCLM Suite Administrator Workbench: User’s Guide in the chapter 
entitled "Getting Started with Enhanced Access Control for SCLM Administration."

Setting a project filter

You can filter the list of objects presented to you in the Navigator tree.  The filters you 
define are host-specific.  That is, if you create a filter on host A, that filter will apply 
only to host A and not to host B.  
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When you first install SCLM Suite Administrator Workbench, the project filter is set to 
an asterisk (*).  All projects appear in your Navigator tree.  To change the filter, at any 
time you can right-click Project Filter in the Navigator Tree, then click Change in the 
pop-up menu that displays.  This causes SCLM Suite Administrator Workbench to 
display the Change System Filter menu on which you can add or change project 
filters.  You can also right-click on a filter listed in the Filter Strings list box on this 
menu to see additional options you can take against a specific filter.   

Note:  A project filter is case-sensitive.  

Starting an SCLM Suite Administrator Workbench session

Your SCLM Suite Administrator Workbench client is now ready for use.  To start a 
work session, see Chapter 6, “Starting an SCLM Suite Administrator Workbench 
Session,” on page 39.
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Part 3. Starting a Session

This part describes the way in which you start an SCLM Suite Administrator 
Workbench session.
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Chapter 6. Starting an SCLM Suite Administrator Workbench 
Session

Once you have completed the installation and customization tasks, you are ready to 
begin using the product.  Follow the directions below to start a session.  Detailed 
information about using SCLM Suite Administrator Workbench are available in the 
IBM SCLM Suite Administrator Workbench : User’s Guide.

Starting a session from the workstation client

To start a new SCLM Suite Administrator Workbench session  

1. Under Windows, log onto the product from the Start menu:
Start > Programs > IBM SCLM Suite Administrator Workbench. Alternatively, 
open a DOS window to the directory where you have installed SCLM Suite 
Administrator Workbench.  At the command prompt enter  sclmawb.bat.

In the UNIX or Linux client environments, ensure you are running under the  X 
Window system and the DISPLAY environment variable is set.  Change 
directories to the WSWB eclipse directory by entering cd WSWB/eclipse.  From a 
command prompt, enter sclmawb.sh.

Note:  Using sclmawb.sh is the only recommended way to begin your use of SCLM 
Suite Administrator Workbench.  Do not execute Eclipse. Do not start multiple 
instances of SCLM Suite Administrator Workbench simultaneously from the same 
user ID, since unpredictable results can occur. 

2. Enter your logon ID and password when prompted. The first time you use the 
product, you should place a check next to Save ID on the logon pop-up.  You may 
optionally want to place a check next to Save Password, which makes it 
unnecessary to reenter your password once you have logged onto the system.

If you have saved your ID or password and need to reset one or both at a later 
date:

a. From the Window pulldown, select Preferences > Remote Systems > 
Passwords. 

b. From the list that displays, select the system on which you want to add, 
change, or remove password information and press OK. 

3. To connect to the host, click SCLM Admin Workbench in the Remote Systems 
View navigator tree.  A pop-up menu may again request your logon ID and 
password for the host system. 

4. When your logon has been accepted, your host session begins. You can now  
create a project or modify an existing project.

Starting a session from the host

To begin a host session, log onto ISPF and enter 10.8 on the command line.  This 
displays the SCLM Suite Administrator Workbench Main Menu from which you can 
choose the task you want to perform.

Note:  When you initially log onto TSO to use SCLM Suite Administrator Workbench, 
your user profile  should have been modified to specify an adequate maximum size 
for your TSO region under RACF.  Typically, this profile modification will have been 
made for you by your site’s systems programmer when setting up SCLM Suite 
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Administrator Workbench. If you are using XML toolkit V1R4, your TSO maximum 
region size should be 20000. If you are using XML toolkit V1R6, your TSO maximum 
region size should be 60000.  
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Part 4. Appendixes
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Appendix A.    Messages and Codes

This appendix documents the messages and codes that may be displayed during the 
operation of SCLM Suite Administrator Workbench, together with actions that may be 
taken by the system, as well as actions that you may need to take.

All messages generated by SCLM Suite Administrator Workbench have a severity 
code printed as the last character of the message ID. The severity codes are described 
in the following table:

   

 
Error Writing File.  There may not be enough temporary 
disk space.  Try using  -is:tempdir to use a temporary 
directory on a partition with more disk space. 

Severity:  Warning

Explanation:  The SCLM Suite Administrator Workbench 
installation program needs a temporary area on disk with 
a sufficient amount of space.  

User Response:  Specify the installation directory as 
follows:: 

mmmmmmmm -is:tempdir "directory-path"

where:

• mmmmmmmm is the name of an installer such as 
AUZLNGTK.bin or AUZWIN32.exe, and

• directory-path represents the path to the temporary 
directory, for example, /tmp/AUZ. 

error.number.tar

Explanation:  During file build or rebuild, if an error 
occurs, a file called error.number.tar is created.  

User Response:  Save the file and notify  support.

AUZ002E  Invalid Selection -- Please enter a 
Valid Option or X to Exit

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter an option that is valid for this 
panel.

AUZ003E  Invalid Value -- Please enter a "B" if 
you would like to run jobs in batch 
mode or "F" to run jobs in foreground 
mode.

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter either B or F..

AUZ004E  Invalid Value -- You must enter a "Y" 
or "N".

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter Y or N.

AUZ006E  Invalid Selection 

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter an option that is valid for this 
panel.

AUZ007E  Invalid Value

Explanation:  You have entered a value that is invalid on 
this panel

Table 2. Error message severity codes

 Severity Code Description

I Information only. No user action required.

W Warning message. Results may not be as expected. 

E Error message. Some may be user-correctable; read the User 
Response to determine the course of action.

S Severe error.  Some may be user-correctable; read the User 
Response to determine the course of action.
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User Response:  Enter a value that is valid for this panel.

AUZ008E  Project XML member not found or 
corrupted.

Explanation:  You have requested to work on a project for 
which the XML member is either unknown or corrupt.

User Response:  Review your project specifications and 
the log file to determine what the problem may be.

AUZ009E  ISPF error: description

Explanation:  You have made an ISPF error as described 
in the message.

User Response:  Correct the error. 

AUZ010E  Error running script

Explanation:  No results file was found after script has 
been run.

User Response:  Ensure you have specified the correct 
path to the script or that the script is in the appropriate 
directory. Correct the error and rerun. 

AUZ011E  Can’t open the file from HFS

Explanation:  You may have insufficient authority to 
create the file or possibly your disk is full.

User Response:  Review your permissions with your 
systems programmer. 

AUZ012I  Project was built successfully

Explanation:  The project has been built successfully.

User Response:  No response is required. 

AUZ013I  Project was created successfully

Explanation:  The project has been created successfully.

User Response:  No response is required. 

AUZ014E  Tag "library" not found in language 
definition

Explanation:  When building a language definition using 
ISPF panels for data entry, you have not included a 
library name.

User Response:  Return to the language definition panels 
and fill in the required field.

AUZ015E  Tag "member" not found in language 
definition

Explanation:  When building a language definition using 
ISPF panels for data entry, you have not included a 
member name.

User Response:  Return to the language definition panels 
and fill in the required field.

AUZ016E  An unrecognized error occurred

Explanation:  An error occurred that  SCLM Suite 
Administrator Workbench cannot identify.

User Response:  Contact your site’s support personnel.

AUZ017E  Can’t parse the project

Explanation:  An error occurred that prevents SCLM 
Suite Administrator Workbench from parsing the project. 

User Response:  Correct the error and try again to parse 
the project.

AUZ018E  Project already exists

Explanation:  You are attempting to create a project 
having the same name as a project that already exists.

User Response:  If the project name you entered is 
correct, display the Project List and continue to work on 
the project in question.  If you meant to create a new 
project, select another name for it.

AUZ019E  Wrong command

Explanation:  You have entered a command that is not 
available for use on this panel.  Refer to the panel for 
those commands that are acceptable.

User Response:  Correct the error and retry.

AUZ020E  Invalid value.  Type Data Set wild 
card.

Explanation:  A value you have entered for the data set 
name is invalid.  Type a wild card in the field to see a list 
of available data sets.  Remember that you must supply at 
least one qualifier with the wild card.

User Response:  Correct the error and retry.

AUZ021E  Source Types not defined

Explanation:  You have not provided values for required 
parameters of the Types you selected to include in your 
project.

User Response:  Correct the error and retry.
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AUZ022E  Data Set or Member not defined

Explanation:  The data set or member is not defined.

User Response:  Correct the error and retry.

AUZ023E  Group Name not defined

Explanation:  You are attempting to use a Group that you 
have not previously defined.

User Response:  Correct the error and retry.   If you 
misspelled the name of the Group, reenter the Group 
name.  If you meant to enter the Group name you 
specified, return to the Groups panel and define this 
group before proceeding. 

AUZ024E  Type Name not defined

Explanation:  You are attempting to use a Type that you 
have not previously defined.

User Response:  Correct the error and retry.   If you 
misspelled the name of the Type, reenter the  name.  If 
you meant to enter the Type name you specified, return 
to the Types panel and define this Type before 
proceeding. 

AUZ025E  Alternate Control Information not 
defined

Explanation:  You have not defined the identifier for the 
alternate control data sets for this project.

User Response:  Correct the error and retry.  

AUZ026E  Primary Accounting Data Set not 
defined

Explanation:  You have not defined the required Primary 
Accounting data set for this project.

User Response:  Correct the error and retry.  

AUZ027E  JCL Data Set not found in project 
XML

Explanation:  There was no JCL data set in the project’s 
generated XML.

User Response:  Define this data set using the Default 
Data Sets panel.  

AUZ030E  Group into which to migrate 
members not defined

Explanation:  You have specified that members are to be 
migrated into a group which you have not yet defined.

User Response:   Define the required group.

AUZ031E  Group into which to migrate 
members not defined

Explanation:  You have specified that members are to be 
migrated into a group which you have not yet defined.

User Response:   Define the required group.

AUZ032E  Language not defined

Explanation:  A language definition is required for the 
project

User Response:   Create the required language definition.

AUZ033E  Authorization code not defined

Explanation:  An authorization code required for the 
project is not defined.

User Response:  Define the required authorization code.

AUZ034E  Change code not defined

Explanation:  A change code required for the project is 
not defined.

User Response:  Define the required change code.

AUZ035E  Mode not defined

Explanation:  The processing mode is not defined.

User Response:  Define the required mode.

AUZ036E  Group not defined

Explanation:  You are referring to a group that is not 
defined.

User Response:  Define the required group.

AUZ037E  Type not defined

Explanation:  You are referring to a Type that is not 
defined.

User Response:  Define the required Type.

AUZ039E  Group groupname  is not defined in the 
project

Explanation:  You are referring to a group that is not 
defined.

User Response:  Define the required group.

AUZ040E  User exit module name not defined 

Explanation:  You have not defined the required field 
called Module Name for this exit.
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User Response:  Define the user exit module name.

AUZ042E  Exit Invocation Method not defined 

Explanation:  You have not defined the required 
Invocation Method.

User Response:  Define the exit invocation method.

AUZ043E  Cannot delete VSAM task from 
skeleton.

Explanation:  You can delete only customized tasks from 
the list, but not predefined tasks.

User Response:  Ensure the task you are attempting to 
delete is a customized task.

AUZ044I  VSAM task taskname successfully 
deleted

Explanation:  Confirmation message that a VSAM task 
you wanted to delete has been deleted.

User Response:  No user action is required.

AUZ045E  Cannot create Architecture Definition

Explanation:  The architecture definition you were 
attempting to create could not be created.

User Response:  Check the log for more information 
about the error or contact your site’s support personnel.

AUZ046E  Cannot create Architecture Definition 
from JCL

Explanation:  The architecture definition you were 
attempting to create could not be created.

User Response:  Check the log for more information 
about the error.

AUZ047E  Cannot complete the migration

Explanation:  The migration of assets into your project 
could not be completed.

User Response:  Check the log for more information 
about the error or contact your site’s support personnel.

AUZ048E  Temporary Archdef file does not exist

Explanation:  The architecture definition files you 
referred to do not exist.

User Response:  Contact your site’s support personnel.

AUZ050E  File tailoring open returned a file 
tailoring already in progress 
condition

Explanation:  The file to be tailored could not be opened 
because tailoring was already in progress.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ051E  File tailoring open returned the 
output file already in use condition

Explanation:  File tailoring could not progress because 
the output file was already open and in use.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ052E  File tailoring open returned the 
skeletal file or output file not 
allocated condition

Explanation:  File tailoring could not progress because 
the required skeleton or output file was not allocated.

User Response:  Allocate the required file.  Review the 
ISPF User’s Guides for information about this issue.

AUZ053E  File tailoring open returned a severe 
error condition

Explanation:  File tailoring could not progress.

User Response:  Contact your site’s support personnel.

AUZ054E  File tailoring open returned an 
unknown code

Explanation:  File tailoring could not progress. 

User Response:  Contact your site’s support personnel.

AUZ055E  File tailoring  close returned a file not 
open condition -- severe error

Explanation:  File tailoring could not progress.

User Response:  Contact your site’s support personnel.

AUZ056E  File tailoring  close returned an 
output file in use condition

Explanation:  The file which you are attempting to close 
is in use.

User Response:  Review the ISPF User’s Guides for 
information about this issue and retry.
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AUZ057E  File tailoring close  returned the 
skeletal file or output file not 
allocated condition

Explanation:  The skeleton file or output file is not 
allocated.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ058E  File tailoring close returned a severe 
error

Explanation:  File tailoring could not progress.

User Response:  Contact your site’s support personnel.

AUZ059E  File tailoring  close returned an 
unknown code -- severe error

Explanation:  File tailoring could not progress. 

User Response:  Contact your site’s support personnel.

AUZ060E  File tailoring  close returned an 
output member exists in the output 
library and NOREPL was specified

Explanation:  An output member of this name already 
exists and you have specified that it should not be 
replaced. 

User Response:  Verify that you do not want to replace 
the output member currently in the output library and 
consider whether NOREPL is what you want to specify.  
Alternatively, determine whether the name of the current 
output file is correct.

AUZ061E  File tailoring  include returned a 
skeleton does not exist condition

Explanation:  File tailoring could not progress because 
the skeleton file to be included does not exist.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ062E  File tailoring  include returned a 
skeleton in use ---ENQ failed 
condition

Explanation:  File tailoring could not progress because 
the skeleton file to be included was in use by another 
program. 

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ063E  File tailoring  include returned a data 
truncation or skeleton library or 
output file not allocated condition.

Explanation:  File tailoring could not progress. 

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ064E  File tailoring  include returned a 
severe error condition

Explanation:  File tailoring could not progress. 

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ065E  File tailoring  include returned an 
unknown condition --  severe error 

Explanation:  File tailoring could not progress. 

User Response:  Contact your site’s support personnel.

AUZ066E  Allocation Error -- An error was 
encountered allocating the ISPFILE 
DD -- Process not completed

Explanation:    The program cannot read or allocate the 
ISPFILE data set.

User Response:  Contact your site’s support personnel.

AUZ067E  Allocation Error -- An error was 
encountered reading the ISPFILE DD 
-- Process not completed

Explanation:  The program cannot read or allocate the 
ISPFILE data set. 

User Response:  Contact your site’s support personnel.

AUZ070E  Cannot resolve the DSN mask

Explanation:   The product cannot resolve a DSN mask 
error. 

User Response:  Contact your site’s support personnel.

AUZ071E  Cannot open a result file

Explanation:  No results file was found after script has 
been run.

User Response:  Ensure you have specified the correct 
path to the script or that the script is in the appropriate 
directory. Correct the error and rerun. 
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AUZ072E  Cannot get list of Architecture 
Definitions

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.

AUZ073E  Cannot delete Project projectname

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ074I  Project projectname successfully 
deleted

Explanation:   SCLM Suite Administrator Workbench 
successfully deleted the named project.

User Response:  No user action is required.

AUZ075I  Project projectname successfully 
deleted

Explanation:   SCLM Suite Administrator Workbench 
successfully deleted the named project.

User Response:  No user action is required.

AUZ076E  Cannot clone Project projectname

Explanation:   SCLM Suite Administrator Workbench is 
unable to clone the named project.

User Response:  Check the log for more information 
about the error.

AUZ077E  Cannot get list of projects

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ078E  Cannot run VSAM task

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ079E  Cannot get list of VSAM tasks

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ080E  Cannot create XML from existing 
project

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ081E  Cannot create LDML from language 
definition source

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ082E  Cannot  create source of Language 
Definition from LDML

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ083E  Cannot create language definition 
from JCL

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ084E  Cannot Build Project

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ085E  Cannot Create Project

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ086I  No projects match filter filter 

Explanation:  There are no projects in the Project List that 
match the filter you have specified

User Response:  To obtain a list of other projects, specify 
a different filter.  Otherwise, no user action is required.
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AUZ087E  Group groupname is not low level 
group of project 

Explanation:  The named group is not at the lowest level 
of the project hierarchy.  Architecture definition is 
allowed only for low level groups.

User Response:  Correct the problem.

AUZ088E  Type typename is not defined in the 
project

Explanation:  The named Type has not been defined in 
the project.  You can define this Type on the Types panel.

User Response:  Define the Type before attempting to 
build the architecture definition.

AUZ089E  Type typename  has wrong attributes

Explanation:  The named Type has been defined with 
incorrect attributes for the Type.

User Response:  Respecify the attributes for this Type. 
An architecture definition can be created only for types 
having RECFM=FB and LRECL=80.

AUZ090E  RECFM is not defined

Explanation:  You have not defined this record format

User Response:  Define the record format.

AUZ091E  BLKSIZE is not defined

Explanation:  You have not defined this block size

User Response:  Define the block size.

AUZ092E  LRECL is not defined

Explanation:  You have not defined this logical record 
length.

User Response:  Define the logical record length.

AUZ093E  Type Name is not valid

Explanation:  The name you have assigned to this Type is 
not valid for this Type

User Response:  Respecify the Type name.

AUZ094E  RECFM is not valid

Explanation:  The record format you have assigned to 
this Type is not valid for this Type

User Response:  Respecify the record format.

AUZ095E  BLKSIZE is not valid

Explanation:  The block size you have assigned to this 
Type is not valid for this Type

User Response:  Respecify the block size.

AUZ096E  LRECL is not valid

Explanation:  The logical record length you have 
assigned to this Type is not valid for this Type

User Response:  Respecify the logical record length.

AUZ097E  Type Name is not valid

Explanation:  The name you have assigned to this Type is 
not valid for this Type

User Response:  Respecify the Type name.

AUZ098E  Alternate Name of typename  Type is 
not valid

Explanation:  The alternate name you have assigned to 
this Type is not valid..

User Response:  Respecify the Alternate Type name.

AUZ099E  No of Members of typename  Type is 
not valid

Explanation:  The value you have specified for the 
Number of Members field for this Type is not valid..

User Response:  Respecify the Number of Members.

AUZ100E  Average Number of Records of 
typename  Type is not valid

Explanation:  The value you have specified for the 
Average Number of Records field for this Type is not 
valid..

User Response:  Respecify the Average Number of 
Records.

AUZ101E  At least one group and one type 
should exist in the project to build it 
successfully

Explanation:  To build a project, you must have defined 
at least one group and one Type for it.

User Response:  Add a group, Type, or both to the project 
if necessary.

AUZ102E  Number of members of typename  
Type  not defined

Explanation:  The Number of Members parameter for 
this Type is not defined.
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User Response:  Define the Number of Members 
parameter.

AUZ103E  Average Number of Records of 
typename  Type  not defined

Explanation:  The Average Number of Records 
parameter for this Type is not defined.

User Response:  Define the Average Number of Records 
parameter.

AUZ104E  Package Backup condition of typename  
Type  not defined

Explanation:  The Package Backup parameter for this 
Type is not defined.

User Response:  Define the Package Backup parameter.

AUZ105E  Flags Pack file condition of typename  
Type  not defined

Explanation:  The Flags Pack file parameter for this Type 
is not defined.

User Response:  Define the Flags Pack file parameter.

AUZ106E  Backout Isapack condition of typename  
Type  not defined

Explanation:  The Backout Isapack parameter for this 
Type is not defined.

User Response:  Define the Backout Isapack parameter.

AUZ107E  Backout Isapack condition of typename  
Type  is not valid

Explanation:  The Backout Isapack parameter for this 
Type is not valid.

User Response:  Respecify the Backout Isapack 
parameter within required limits. .

AUZ108E  Package Backup condition of typename  
Type  is not valid

Explanation:  The Package Backup parameter for this 
Type is not valid.

User Response:  Respecify the Package Backout 
parameter within required limits. 

AUZ109E  Flags Pack file condition of typename  
Type  is not valid

Explanation:  The Flags Pack file parameter for this Type 
is not valid.

User Response:  Respecify the Flags Pack file parameter 
within required limits. 

AUZ110E  Reuse limits of typename  Type  not 
defined

Explanation:  The Reuse Limits parameter for this Type is 
not defined.

User Response:  Define the Reuse Limits parameter.

AUZ111E  Reuse Limits condition of typename  
Type  is not valid

Explanation:  The Reuse Limits parameter for this Type is 
not valid.

User Response:  Respecify the Reuse Limits parameter 
within required limits. 

AUZ112E  The topmost group already exists in 
the project

Explanation:  You have already defined this group as the 
topmost group within this project.

User Response:  Redefine this group.

AUZ113E  Project must have the only topmost 
group

Explanation:  Only one group can not have a promotion 
group.  That is the group at the top of the tree.

User Response:  Ensure that only one group does not 
have a promote group, and that that group is at the top of 
the tree.

AUZ114E  Promote group must exist

Explanation:  You must define a group as a promote 
group in this project.

User Response:  Define a group in this project as the 
promoter group

AUZ115E  The group with the same name 
already exists in the project

Explanation:  You have defined two groups in the project 
with the same name.

User Response:  Rename one of the groups.

AUZ116E  The topmost group should be the key

Explanation:  You have not specified the Key parameter 
for the topmost group in your hierarchy.

User Response:  Specify the topmost group in your 
project hierarchy as the key group.
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AUZ117E  Development group groupname should 
be the key

Explanation:  The group named in the message should be 
the key group.

User Response:  Redefine this group to be the key group.

AUZ118E  You have a loop in promotions for 
group groupname

Explanation:  When defining promotion from group to 
group, there can be no loops. You cannot define a 
promote sequence that has group A promoting to group 
B which in turn promotes back to group A. 

User Response:  Redefine your Promote sequence.

AUZ119E  An FLMALTC macro must have at 
least one FLMGROUP ALTC  
parameter pointing to it

Explanation:  When defining an alternate control group, 
you must ensure that each occurrence of an FLMALTC 
macro has at least one ALTC parameter on an 
FLMGROUP (group definition) macro pointing to it.

User Response:  Redefine a group definition macro to 
point to the alternate control group.

AUZ120E  FLMCTRL macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP in the DSNAME parm.  
If it is specified, DSNAME must 
include @@FLMTYP.

Explanation:  When defining control data sets, the 
DSNAME parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP .

User Response:  Redefine the FLMCTRL  macro.

AUZ121E  FLMALTC macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP in the DSNAME parm.  
If it is specified, DSNAME must 
include @@FLMTYP.

Explanation:  When defining control data sets, the 
DSNAME parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP .

User Response:  Redefine the FLMALTC  macro.

AUZ122E  FLMCTRL macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMUID in the EXPACCT parm.

Explanation:  When defining control data sets, the 
EXPACCT parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMUID .

User Response:  Redefine the FLMCTRL  macro.

AUZ123E  FLMALTC macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMUID in the EXPACCT parm.

Explanation:  When defining control data sets, the 
EXPACCT  parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMUID.

User Response:  Redefine the FLMALTC  macro.

AUZ124E  FLMCTRL macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP,  @@FLMDSN in the 
VERPDS parm.  If @@FLMDSN is 
used,  it must be specified in the first 
8 characters.

Explanation:  When defining control data sets, the 
VERPDS parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP  and 
@@FLMDSN.

User Response:  Redefine the FLMCTRL  macro.

AUZ125E  FLMALTC macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP, @@FLMDSN in the 
VERPDS parm.  If @@FLMDSN is 
used,  it must be specified in the first 
8 characters.

Explanation:  When defining alternate control data sets, 
the VERPDS parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP  and 
@@FLMDSN.

User Response:  Redefine the FLMALTC  macro.

AUZ126E  FLMCTRL macros cannot  use SCLM 
variables in ACCT and ACCT2 parms.

Explanation:  When defining control data sets, SCLM 
variables cannot be used when defining ACCT and 
ACCT2 parameters.

User Response:  Redefine the FLMCTRL  macro.

AUZ127E  FLMALTC macros  cannot  use SCLM 
variables in ACCT and ACCT2 parms.

Explanation:  When defining alternate control data sets, 
SCLM variables cannot be used when defining ACCT 
and ACCT2 parameters.

User Response:  Redefine the FLMALTC  macro.

AUZ128E  FLMCTRL macros cannot  use SCLM 
variables in VERS and VERS2 parms.

Explanation:  When defining control data sets, SCLM 
variables cannot be used when defining VERS and 
VERS2 parameters.
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User Response:  Redefine the FLMCTRL  macro.

AUZ129E  FLMALTC macros  cannot  use SCLM 
variables in VERS and VERS2 parms.

Explanation:  When defining alternate control data sets, 
SCLM variables cannot be used when defining VERS and 
VERS2 parameters.

User Response:  Redefine the FLMALTC  macro.

AUZ130E  If PACKFILE=Y then typename should 
have RECFM=FB and LRECL=130

Explanation:  If the specification of the PACKFILE 
parameter is Yes, then the named Type should have a 
record format of fixed block and a logical record length of 
130.

User Response:  Respecify values for the named Type.

AUZ131E  If  RECFM=U, LRECL must be 0

Explanation:  If the record format is unblocked, logical 
record length must be 0.

User Response:  Respecify the values.

AUZ132E  If  RECFM=U,  BLKSIZE must not be 
0 or <= 32760

Explanation:  If the record format is unblocked, block 
size must not be 0 and must be less than or equal to 
32760.

User Response:  Respecify the values.

AUZ133E  If  RECFM=VBx,  LRECL must not be 
0 

Explanation:  If the record format is variable blocked, 
logical record length must not be 0.

User Response:  Respecify the values.

AUZ134E  If  RECFM=VBx,  BLKSIZE must be 0 
or >= LRECL +4 and <= 32760

Explanation:  If the record format is variable blocked, 
block size must either be 0 or must be greater than or 
equal to logical record length plus 4 and less than or 
equal to 32760.

User Response:  Respecify the values.

AUZ135E  If  RECFM=FBx,  LRECL must not be 
0

Explanation:  If the record format is fixed block, logical 
record length  must not be 0.

User Response:  Respecify the values.

AUZ136E  If  RECFM=FBx,  BLKSIZE must be 0 
or an exact multiple of LRECL and <= 
32760

Explanation:  If the record format is fixed blocked, block 
size must either be 0 or must be an exact multiple of the  
logical record length and less than or equal to 32760.

User Response:  Respecify the values.

AUZ137I  Project projectname successfully parsed

Explanation:  The project whose name appears in the 
message has been successfully parsed --XML has been 
generated for this project.

User Response:  No action is required.

AUZ138E  Authorization group authgroup_name   
has authorization code loop.

Explanation:  An example of a loop that must be avoided 
is the case where authorization group AGRP1 contains 
authorization codes A, B, C, AGRP2, and authorization 
group AGRP2 contains authorization codes A, B, D, 
AGRP1. This specification is invalid.

User Response:  Correct the authorization group 
specification.

AUZ139E  Authorization code loop exists.

Explanation:  An example of a loop that must be avoided 
is the case where authorization group AGRP1 contains 
authorization codes A, B, C, AGRP2, and authorization 
group AGRP2 contains authorization codes A, B, D, 
AGRP1. This specification is invalid.

User Response:  Correct the authorization code 
specification.

AUZ140E  DASD unit not defined

Explanation:  You have not specified a DASD unit.

User Response:  Define the DASD unit.

AUZ141E  DASD unit invalid value

Explanation:  The DASD unit specification you entered is 
invalid.

User Response:  Correct the  specification.

AUZ142E  VIO unit not defined

Explanation:  You have not specified a Virtual 
Input/Output (VIO) unit.

User Response:  Define the VIO unit.
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AUZ143E  VIO unit invalid value

Explanation:  The VIO unit specification you entered is 
invalid.

User Response:  Correct the  specification.

AUZ144E  Max VIO Records not defined

Explanation:  You have not specified the maximum 
number of  records permitted for VIO allocation.

User Response:  Define the parameter Max VIO Records.

AUZ145E  Max VIO Records invalid value -- 
must be numeric

Explanation:  The specification you entered for Max VIO 
Records is invalid. Ensure the value is numeric.

User Response:  Correct the  specification.

AUZ146E  Max lines per report page  not defined

Explanation:  You have not specified the maximum 
number of lines to be written to a report page.

User Response:  Define the parameter Max Lines per 
Report Page.

AUZ147E  Max lines per report page  invalid 
value -- must be numeric

Explanation:  The specification you entered for Max lines 
per report page is invalid. Ensure the value is numeric.

User Response:  Correct the  specification.

AUZ148E  Max lines  per report page  should be 
greater than or equal to 35

Explanation:  The specification you entered for Max lines 
per report page should be greater than or equal to 35.

User Response:  Correct the  specification.

AUZ149E  Promotion group promote_groupname 
for group groupname  must exist

Explanation:  The named promote group does not exist.

User Response:  Define the missing promote group.

AUZ150E  The Type typename wasn’t used in 
Group-Type combination

Explanation:  You have not used the named Type in any 
Group/Type combination.

User Response:  Respecify the Group/Type if necessary.

AUZ151E  The Group groupname wasn’t used in 
Group-Type combination

Explanation:  You have not used the named Group in any 
Group/Type combination.

User Response:  Respecify the Group/Type if necessary.

AUZ152E  The Type typename is not defined in 
the project

Explanation:  You have not defined the named Type for 
this project.

User Response:  Respecify or select the Type if necessary.

AUZ153E  The Group groupname is not defined 
in the project

Explanation:  You have not defined the named group for 
this project.

User Response:  Respecify or select the group if 
necessary.

AUZ154E  A member with the same name 
already exists

Explanation:  You are attempting to define a new 
member having the same name as an existing member.

User Response:  Correct the error.

AUZ155E  Invalid Script Log File

Explanation:  A script was not running at the time the 
error occurred, resulting in an invalid script log file.

User Response:  No action is required.

AUZ156E  Invalid Script Result File

Explanation:  A script was not running at the time the 
error occurred, resulting in an invalid script results file.

User Response:  No action is required.

AUZ157E  Invalid unit selection

Explanation:  You have selected a DASD unit that is not 
available or not valid.

User Response:  Correct the error.

AUZ158E  Allocation Units is not defined

Explanation:  You have not specified the allocation unit 
to be used; for example, tracks, blocks, or cylinders.

User Response:  Correct the error.
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AUZ159E  Initial Allocation is not defined

Explanation:  You have not specified the value to be used 
for the initial allocation.

User Response:  Correct the error.

AUZ160E  Must be numeric

Explanation:  You are attempting to enter a non-numeric 
value in a field that must be numeric.

User Response:  Correct the error.

AUZ161E  Value out of range

Explanation:  The value you have entered in this field is 
either too small or too large.

User Response:  Correct the error.

AUZ162E  Secondary Allocation is not defined

Explanation:  You have not specified the value to be used 
for the secondary allocation.

User Response:  Correct the error.

AUZ163E  Audit Data Set must be selected

Explanation:  Selecting an Auditing Data Set is 
mandatory based on your other selections on this panel

User Response:  Correct the error.

AUZ164E  Number of versions is not defined

Explanation:  You have specified versioning is to be 
active but have not specified the number of versions to be 
retained.

User Response:  Correct the error.

AUZ165I  Migrate completed successfully

Explanation:  You have successfully migrated assets into 
your project.

User Response:  No user action is required.

AUZ166I  Architecture Definition was created 
successfully

Explanation:  You have successfully created an 
architecture definition.

User Response:  No user action is required.

AUZ167E  Cannot run script

Explanation:  The script you required to be run failed to 
run.

User Response:  Contact your site’s support personnel.

AUZ168E  Error code error code was returned.

Explanation:  An unknown error has occurred.

User Response:  Review the output and the error log or 
Contact your site’s support personnel.

AUZ170E  Error occurred

Explanation:  An unknown error has occurred.

User Response:  Review the output and the error log or 
Contact your site’s support personnel.

AUZ171E  The Type with the same name is 
already defined

Explanation:  You are attempting to define a new Type 
having the same name as a Type that is already defined.

User Response:  Rename the Type you are defining.

AUZ172E  SCLM Output Type not defined.

Explanation:  You have not provided the required 
parameter definitions for the Output Type.

User Response:  From the Default Types panel or 
Selected Types panel, provide any missing information 
for the Output Type.

AUZ173E  SCLM List Type not defined.

Explanation:  You have not provided the required 
parameter definitions for the List Type.

User Response:  From the Default Types panel or 
Selected Types panel, provide any missing information 
for the List Type.

AUZ174E  Architecture Definition Language 
language isn’t defined in project

Explanation:  You are attempting to use an invalid 
language in your architecture definition.

User Response:  Use the Language Definition Wizard to 
define the language you want to use in this Architecture 
Definition.

AUZ175E  Architecture Definition Language not 
defined 

Explanation:  You have left the language definition field 
for this architecture definition empty.
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User Response:  Supply a valid language in your 
architecture definition.

AUZ176E  The Type with the same name already 
exists in the project

Explanation:  You are attempting to move a default Type 
into your project that has  the same name as a Type that is 
already defined in the project.

User Response:  Determine whether you are moving a 
duplicate default Type into the project and decide 
whether to do so.  Alternatively, rename the Type you 
have selected.

AUZ1000E  No contributions found for this 
action.

Explanation:  Internal error

User Response:  Contact your site’s support personnel.

AUZ1001E  Cannot instantiate a Menu Action 
class: description

Explanation:  An internal error has occurred and is 
described to you.

User Response:  Contact your site’s support personnel.

AUZ1002E  Error detected in location

Explanation:  An internal error has occurred at the 
location specified in the message.

User Response:  Contact your site’s support personnel.

AUZ1003E  EAC exception: message

Explanation:  The Enhanced Access Control for SCLM 
exception indicated by the message text of this message 
has occurred.

User Response:  Contact your site’s support personnel.

AUZ1004E       Default EAC Rule File not found.

Explanation:  You must specify a default rule file.

User Response:  Go to the Window pulldown, select 
Preferences > EAC Manager, and specify a default rule 
file.

AUZ1005E  Connection timed out.  Host processes 
may still be active.

Explanation:  A command or file transfer operation has 
not completed within a reasonable time and the 
workstation program has stopped waiting. Host-side 

processes may still be running on behalf of the request 
and were not cancelled.

User Response:  Verify the status of the operation before 
initiating further work on the project.

AUZ1006E  message

Explanation:  An internal error as described in the 
message has occurred.

User Response:  Contact your site’s support personnel.

AUZ1007W       Only a simple filter can be used for 
the project filter - for example, CCC*

Explanation:  When you are defining a filter to be used to 
filter the project list that will be displayed to you at the 
workstation, you may not specify a complex filter; that is, 
a filter with more than one term.

User Response:  Reformulate your filter to have only one 
term.

AUZ1008E       Error obtaining command results

Explanation:  An I/O error occurred getting results back 
from the host system. 

User Response:  Retry. If the error reoccurs, call your 
support personnel.

AUZ1009E       Error: RSE temp files project not 
found

Explanation:  SCLM Suite Administrator Workbench 
depends on the RSE subsystem to establish a project for 
temp files (RemoteSystemTempFiles).

User Response:  Contact your support personnel.

AUZ1010E       Not connected to mainframe yet.

Explanation:  While trying to create a folder in RSE 
RemoteSystemTempFiles project, the MVS userid could 
not be resolved since the user is not connected to the 
mainframe.

User Response:  Ensure you are connected to the host 
and retry.

AUZ1011E       Error: Can’t create AUZ temporary 
folder.

Explanation:  While trying to create a temporary folder in 
RSE RemoteSystemTempFiles project, an error occurred.

User Response:  Ensure you have required permissions 
or call your support personnel.
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AUZ1012E       Only one active EAC rule data set 
allowed per system. Please remove 
existing mapping and retry.

Explanation:  Indicates that you have selected a system  
to add a rule file to that already has an EAC rule file 
associated with it in EAC Manager preferences.

User Response:  To associate the system with the given 
EAC rule file, set the System name back to <Select> 
status, then choose another system.

AUZ1013E       Invalid rule data set name.

Explanation:  The name you have selected for your EAC 
rule file does not follow MVS data set naming 
conventions.

User Response:  Ensure your data set name follows MVS 
data set naming conventions.  Please respecify the data 
set  name.

AUZ5000S      Usage: project PROJECT DEFINITION 
<name> <alternate> <member> 
<output_file>  <input_file> 
library_pds_1  [library_pds_2-10]  
[trace_level= <trace_level>]

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5001S      Invalid Markup Language Type  
<markup language type>

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5002S      Usage:  <filename>COPYBOOK  
<name> <alternate> <member> 
<output_file> nest=<nesting_level> 
library_pds_1  [library_pds_2-10]  
[trace_level= <trace_level>]

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5003S      Nesting level too large recursive 
copies?

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5004S      Nesting level  must be specified

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5005E      Unable to open output file filename, 
errno=error number 

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Correct the problem.

AUZ5006E      Unable to open input file filename, 
errno=error number 

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Correct the problem.

AUZ5007I      variable message indicating command 
being run to parse copybook

System Action:  The program continues.

User Response:  No action is required.

AUZ5050E      NOT FOUND errno=error number  

Explanation:  An error has occurred when parsing the 
project.  

User Response:  Correct the problem.   A possible  
correction is to correct the default data set specification.

AUZ8100S  Unauthorized to run AUZREACRM

System Action:  Program terminates.

Explanation:  You do not have sufficient authority to run 
this program.

User Response:  Ensure that your RACF authority is 
RACF  SPECIAL

AUZ8101S  Invalid Parameters

System Action:  Program terminates.
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Explanation:  The parameters supplied are invalid.

User Response:  Call IBM Support.

AUZ8102E  Unable to reserve EAC Rule File 
(Exclusive)

Explanation:  The Rule File you specified may be in use 
and cannot be reserved to your use exclusively.

System Action:  Program ignores this request.

User Response:  Retry later.  If problem persists, call IBM 
support.

AUZ8103E  Unable to reserve EAC Rule File 
(Shared)

Explanation:  The Rule File you want to use is 
unavailable.

System Action:  Program ignores this request.

User Response:  Retry later.  If problem persists, call IBM 
support.

AUZ8104S  Unable to  load HSSGDBUF.

Explanation:  HSSGDBUF may not be in the link list or in 
the same library as AUZEACRM.

System Action:  Program ignores this request.

User Response:  Contact your site’s support personnel.

System Programmer Response:  Ensure HSSGDBUF is in 
LINKLIST or in same library as AUZEACRM.

AUZ8105S  Error obtaining Violation Buffer

Explanation:  The Violation Buffer is unavailable.

System Action:  Program  terminates.

User Response:  Call IBM support.

AUZ8106E  application not found

Explanation:  You have attempted to run an application 
that does not exist or cannot be found.

System Action:  Program ignores this request.

User Response:  Request an application that exists.

AUZ8107S  Unable to open EAC Rule File

Explanation:  You have specified an incorrect or 
nonexistent Rule File.

System Action:  Program ignores this request.

User Response:  Ensure that you specified a correct Rule 
File.
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Appendix B. Accessibility Features of the Workstation 
Component

Accessibility features help users who have a physical disability, such as restricted 
mobility or limited vision, to use software products successfully. This appendix 
describes the most commonly used accessibility features of  SCLM Suite 
Administrator Workbench. The following sections explain how to use these 
accessibility features on the Windows platform.

To review a complete list of the accessibility features supported by the Eclipse 
platform, refer to "Accessibility Features in Eclipse" in the "Concepts" section of the 
WebSphere Studio Workbench User Guide. To access this user’s guide, from SCLM 
Suite Administrator Workbench menu bar, select Help > Help Contents. Select 
Workbench User Guide from the list of topics that is displayed.

Operating SCLM Suite Administrator Workbench by using the keyboard 

SCLM Suite Administrator Workbench allows you to use the keyboard in place of the 
mouse for many functions. The product can be controlled to a large extent using 
keyboard shortcuts. You can use keys or key combinations to perform operations that 
can also be accomplished through mouse actions. You can access menu items  from 
the keyboard. You can review a subset of the keyboard shortcuts available to you 
using the Window > Keyboard Shortcuts dialog.  When using a pulldown menu, the 
keyboard equivalent typically appears to the right of the menu item. Some keyboard 
items also have shortcuts. Typically, the shortcut letter is underlined in the pulldown 
menu item’s command.  

Optionally, you can customize the function of your keyboard.  Information on how to 
do so can be found in the "Concepts" section of the WebSphere Studio Workbench 
User Guide.  Access the User Guide and then search on the term keys. To customize 
your keyboard while using SCLM Suite Administrator Workbench, select Window > 
Preferences > Workbench > Keys.

To navigate through a window or dialog by using the keyboard instead of the mouse, 
use the following keyboard shortcuts: 

   
Table 3. Navigating through a window or dialog using the keyboard 

Action Shortcut

Access the menu bar in a window F10 or Alt+shortcut letter

Activate a menu item in the menu bar  Enter

Cycle to editor Ctrl+F6

Cycle to a view Ctrl+F7

Cycle to a perspective Ctrl+F8

Access controls in a dialog Alt+shortcut letter

Navigate through the menu bar Right arrow, left arrow, down arrow, up 
arrow 

Move to the next set of controls Tab or Ctrl+Tab

Move to the previous set of controls Shift+Tab 
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To perform main tasks in windows by using the keyboard instead of the mouse, use 
the following keyboard shortcuts:

   

Move within tables Tab or right arrow, Shift+Tab or left arrow, 
down arrow, up arrow

Move within trees Up arrow, down arrow

Expand a tree node Right arrow

Collapse a tree node Left arrow

Move within list boxes Up arrow, down arrow 

Move within drop-down list boxes Up arrow, down arrow

Table 4. Keyboard shortcuts for windows

Action Shortcut

Display Help for the field that has the focus F1

Close the active window Ctrl+F4 or Alt+F4

Close all windows Ctrl+Shift+F4

Save Ctrl+S

Save all Ctrl+Shift+S

Properties Alt+Enter

Cut (Does not currently work in every SCLM 
Administration Manager text field.)

Ctrl+X 

Copy (Does not currently work in every 
SCLM Administration Manager text field. 
However, placing the cursor in a text field 
and right-clicking offers the opportunity to 
select Copy from a pop-up menu.)

Ctrl+C

Paste (Does not currently work in every 
SCLM Administration Manager text field. 
However, placing the cursor in a text field 
and right-clicking offers the opportunity to 
select Paste from a pop-up menu.)

Ctrl+V

Select all Ctrl+A

Find/Replace Ctrl+F

Print Ctrl+P

Return to previously displayed window 
(Back)

Alt+left arrow

Move forward to previously displayed 
window (Forward)

Alt+right arrow

Go to last edit location Ctrl+Q

Table 3. Navigating through a window or dialog using the keyboard 

Action Shortcut
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To perform main tasks in dialogs by using the keyboard instead of the mouse, use the 
following keyboard shortcuts:

   

 

Other accessibility features

In addition to the keyboard features described in this section, SCLM Suite 
Administrator Workbench permits the use of the following accessibility features 
provided by the Eclipse platform:

• Screen-reader software and a digital speech synthesizer to hear what is displayed 
on the screen

• Voice recognition software to enter data and to navigate the user interface

• The ability to magnify what is displayed on the screen in the graphical views

• The ability to modify fonts and colors using the Window > Preferences dialog

Search. 
Note that once the pop-up search dialog 
displays, press Shift+Tab to highlight the tabs 
in the search dialog and then the right or left 
arrows to move through the tab set.

Ctrl+H

Table 5. Keyboard shortcuts for dialogs 

Action Shortcut

Confirm a dialog Enter

Cancel a dialog Esc

Activate a button that has the focus Spacebar or Enter

Select and deselect check boxes and radio 
buttons

Spacebar

Navigate forward within a check box and 
radio button group

Tab 

Navigate backward within a check box and 
radio button group

Shift+Tab 

Open drop-down list box menu Alt+down arrow 

Close drop-down list box menu Esc

Move up and down in combination box 
menu

Up arrow, down arrow

Activate drop-down list box menu item Enter

Move within a list box Up arrow, down arrow

Activate a list box entry Enter

Move between the pages of a window 
containing tabs if the tab has the focus

Right arrow, left arrow

Table 4. Keyboard shortcuts for windows

Action Shortcut
 Appendix B.   Accessibility Features of the Workstation Component  61



 

 62 IBM Software Configuration and Library Manager Suite Administrator Workbench: Installation and Customization Guide  



Appendix C. Notices

This information was developed for products and services offered in the U.S.A. IBM 
may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, 
or service is not intended to state or imply that only that IBM product, program, or 
service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, 
it is the user's responsibility to evaluate and verify the operation of any non-IBM 
product, program, or service.

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not give you any 
license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY  10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM 
Intellectual Property Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: INTERNATIONAL 
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this publication 
at any time without notice.

Any references in this publication to non-IBM Web sites are provided for convenience 
only and do not in any manner serve as an endorsement of those Web sites. The 
materials at those Web sites are not part of the materials for this IBM product and use 
of those Web sites is as your own risk.

Licensees of this program who want to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 

IBM Corporation
J46A/G4
555 Bailey Avenue
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San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary 
significantly. Some measurements may have been made on development-level 
systems and there is no guarantee that these measurements will be the same on 
generally available systems. Furthermore, some measurement may have been 
estimated through extrapolation. Actual results may vary. Users of this document 
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those 
products.

All statements regarding IBM's future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to 
change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to 
change before the products described become available.

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which 
illustrates programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, 
for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating 
platform for which the sample programs are written. These examples have not been 
thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply 
reliability, serviceability, or function of these programs.

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear.

Trademarks

The following terms are trademarks of the IBM Corporation in the United States or 
other countries or both:
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InstallShield is a registered trademark of InstallShield Software Corporation.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the 
United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other 
countries.

Other company, product and service names may be trademarks or service marks of 
others.

AIX
IBM
OS/390
RACF
Redbooks
WebSphere
z/OS 
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Bibliography

This bibliography lists the publications for IBM 
products that are related to the SCLM Suite 
Administrator Workbench product, or publications 
that  you may need to consult when using the 
Workbench. For a complete listing of,  and access to, 
all of the books in a particular library, visit the IBM 
web site at www.ibm.com and search for the library 
in question.  Links to some of the libraries cited in 
this bibliography can be found in the Preface to this 
manual.

Software Configuration and 
Library Manager Suite

 The documents in this section are those comprising 
the SCLM library and the libraries of products that 
are part of the SCLM Suite.

• z/OS ISPF  Software Configuration and Library 
Manager: Project Manager’s and Developer’s 
Guide, SC34-4817

• z/OS ISPF  Software Configuration and Library 
Manager: Reference, SC34-4818

• Software Configuration and Library Manager 
Suite Administrator Workbench: User’s Guide,  
SC31-6571

• Software Configuration and Library Manager 
Suite Administrator Workbench: Installation and 
Customization Guide, GC31-6787

• Enhanced Access Control for SCLM for z/OS: 
User’s Guide, SC27-1591

• IBM Breeze for SCLM : Installation Guide, SC31-
8819

• IBM Breeze for SCLM : Planning and 
Administration Guide, SC31-8817

• IBM Breeze for SCLM : User’s Guide, SC31-8820

• IBM Cloud 9 for SCLM : Installation Guide,  
SC31-8845

• IBM Cloud 9 for SCLM : User’s Guide, SC31-
8846

IBM Interactive System 
Productivity Facility (ISPF) for 
z/OS 

For information on navigating through ISPF, 
understanding PF key functions, and working in an 
ISPF  session, refer to the following manuals:

• ISPF: User’s Guide, Volume I, SC34-4822

• ISPF: User’s Guide, Volume II, SC34-4823

z/OS TSO/E

The following manuals provide introductory and 
use information about TSO/E.

• z/OS TSO/E: Primer, SA22-7787

• z/OS TSO/E: User’s Guide, SA22-7794

TCP/IP

The TCP/IP documentation is a part of the IBM 
z/OS Communications Server library. You will 
need to customize TCP/IP to invoke REXEC. The 
following manuals will assist you in making 
appropriate TCP/IP modifications:

• z/OS Communications Server: IP Configuration 
Guide, SC31-8775

• z/OS Communications Server: IP Configuration 
Reference, SC31-8776

z/OS UNIX System Services

Use the UNIX System Services documentation to 
understand how to enter shell commands to 
request services from the system; write and run 
shell scripts; switch between the shells and TSO/E; 
move MVS data sets into the file system or move 
files from the file system to MVS; enter shell 
commands; create or edit a file in the file system; 
and manage your file system.

• z/OS UNIX System Services : User’s Guide, 
SA22-7801

• z/OS UNIX System Services : Planning, SA22-
7800

• z/OS UNIX System Services : Command 
Reference, SA22-7802

• z/OS UNIX System Services : Messages and 
Codes, SA22-7807

Additional Information

You may also want to refer to some of the IBM 
RedBooks, available online at www.ibm.com.  You 
may find the following useful:
© Copyright IBM Corp.  2004  67



 

• IBM RedBook: Hierarchical File System Usage 
Guide, SG24-5482
 68 IBM Software Configuration and Library Manager Suite Administrator Workbench: Installation and Customization Guide  



Index

A
about SCLM Suite Administrator 

Workbench 3
accessibility

navigating in a workstation 
panel vii

accessibility features vii
of the workstation component 

59
other 61
using the workstation keyboard 

59
activate OMVS 23
AIX

installing on 29
APF authorization

required for SAUZLOAD 10
required for XML LOADLIBs 

10
AUZ CLIST, customizing 14
AUZ.SAUZPAX 10
AUZCLIST 15
AUZFLMD 14
AUZFLMRN, customizing 14
AUZUNPAX

listing 11
AUZUNPAX, customizing 10
AUZUNPAX, modifying .profile 

when reinstalling SCLM 
Suite Administrator 
Workbench 10

B
block size, default DCB 34

C
CEE.SCEERUN

requirement to link-list 23
client, starting SCLM Suite 

Administrator Workbench 
session from 35

CLIST AUZ
customizing 14
listing 15

CLIST AUZCLIST
customizing 14
listing 16

CLIST customization
using correct case (upper or 

lower) when 
specifying parameters 
5

clone project, running in 
background 3

configure OMVS 23
configuring the workstation client 

29
copying from a text field vii
create project, running in 

background 3
customization

for the MVS component 14
for the RSE component 17
for the USS component 17

ispf.sh 17
customizing

host part of RSE 17
MVS component 9

customizing AUZFLMRN 14
customizing AUZUNPAX 10
customizing PARMLIB 23
customizing SCLM Suite 

Administrator Workbench 
9

customizing TCP/IP to invoke 
REXEC 23

customizing the AUZ CLIST 14
customizing the host component 9
customizing the software 8
customizing the workstation client 

29, 31

D
data set search filter, setting 33
DCB

default block size 34
default logical record length 34
default record format 34

DCB information, default 34
default DCB block size 34
default DCB information 34
default DCB record format 34

E
Enhanced Access Control for SCLM 

violations
customization required to view 

25

F
filter, data set search 33
filter, project

setting 34
FLMDMN, renaming 14

H
host component

installing and customizing 9
host component, customizing 9
host component, installing 9
host session, starting 25
host, starting a session on 39
HP-UX

installing on 29

I
initiating a host session 25
initiating a session using the 

workstation 35
installation

actions if installation fails 30
additional requirements 22
required products 7
specifying TSO(HOLDCLASS) 

24

temporary disk space for the 
installer 30

Installation and Customization
conventions used in v
terminology used in v

installer
sufficient temporary disk space 

for 30
installing

host part of RSE 17
MVS component 9
on UNIX-based systems 29
on Windows 29

installing into an existing workspace 
31

installing the host component 9
installing the workstation client 29
InstallShield MultiPlatform installer 

30
ispf.sh

listing 22
requirement to customize 17

K
keyboard, using 59

L
Linux

installing on 29
listing

CLIST AUZ 15
CLIST AUZCLIST 16
ispf.sh 22
setup.sh 20

logical record length, default DCB 
34

LookAt message retrieval tool vi
LRECL, default DCB 34

M
message retrieval tool, LookAt vi
MVS component

customizing 9
installing 9

N
notices 63

O
OMVS REXEC, configuring and 

activating 23
OMVS segment, modifying user’s 

25
OMVS, configure and activate 23

P
PARMLIB, customizing 23
pasting into a text field vii
preferences
© Copyright IBM Corp.  2004  69



 

background
clone project 3
create project 3
VSAM file maintenance 3

Remote Systems Explorer 34
SCLM Suite Administrator 

Workbench 32
running jobs online or in 

batch 33
setting a data set search 

filter 33
setting DCB values for 

default Types 33
setting default job card 

information 33
products, required 7
products, required for installation 7
project filter

setting 34
Project Wizard

about 3

R
RACF

specifying TSO(HOLDCLASS) 
under 24

record format, default DCB 34
region size, TSO 24
reinstalling Administrator 

Workbench
modify your .profile before 

running AUZUNPAX 
10

Remote Systems Explorer
customizing the host side of 17

Remote Systems Explorer 
preferences 34

required products 7
requirements, additional installation 

22
REXEC, invoking 23
RSE, host part of

installing and customizing 17

S
SAUZLOAD

requirement to APF-authorize 
23

SAUZUNPAX 10
SCLM Suite Administrator 

Workbench
about 3
starting 35

SCLM Suite Administrator 
Workbench preferences 32

screen readers and magnifiers vii
session, starting on the host 39
session, starting on the workstation 

39
setup.sh

installing and customizing 17
listing 20

SMP/E installation 9
software, customizing 8
Solaris

installing on 29
starting a host session 25
starting a session using the 

workstation 35
starting SCLM Suite Administrator 

Workbench from a client 
35

T
TCP/IP, customizing to invoke 

REXEC 23
text field

copying from vii
pasting into vii
pasting into’ pasting into a text 

field vii
trademarks 64
TSO region size

specifying under RACF 24
TSO(HOLDCLASS), specifying 

under RACF 24

U
Uninstall Wizard 31
uninstalling the product 31
UNIX System Services

customizing 17
installation directories for 17

UNIX, installing on 29
UNIX-based systems

installing on 29
UNPAX

listing 11
UNPAX, customizing 10
USS. See UNIX System Services

V
violations, Enhanced Access Control 

for SCLM
customization required to view 

25
VSAM file maintenance, running in 

background 3

W
Windows, installing on 29
workstation

starting a session using 35
workstation client

installing and configuring 29
workstation client, installing 29
workstation client, starting a session 

on 39
 70 IBM Software Configuration and Library Manager Suite Administrator Workbench: Installation and Customization Guide  



Readers’ Comments—We’d Like to Hear from You

IBM Software Configuration and Library Manager Suite Administrator Workbench
 Installation and Customization Guide
Version 1  Release 1 

Publication No. GC31-6787-02
Overall, how satisfied are you with the information in this book?

How satisfied are you that the information in this book is:

Please tell us how we can improve this book:

Overall satisfaction

Very Satisfied           Satisfied                Neutral              Dissatisfied                Very
                                                                                                                                                         Dissatisfied

                                                                                                                             Dissatisfied
Very Satisfied           Satisfied                Neutral              Dissatisfied                Very

Accurate
Complete
Easy to find
Easy to understand
Well organized
Applicable to your tasks

Thank you for your response. May we contact you?    ❏  Yes    ❏   No

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏❏❏❏❏

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

AddressName

Company or Organization

Phone No.



    
Cut or Fold
Along Line

- - - - - - 

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

 

- - - - - - 

IBM@

GC31-6787-02

International Business Machines Corporation
IBM Corporation -- Attn: Susie Sanchez 
M46A/H251/SVL 
555 Bailey Avenue 
San Jose, CA 
U.S.A. 
95141 - 9989
Fold and Tape Please do not staple Fold and Tape

Fold and Tape Fold and Tape

NO POSTAGE
NECESSARY
IF MAILED IN THE
UNITED STATES

BUSINESS REPLY MAIL
FIRST-CLASS MAIL PERMIT NO. 40 ARMONK, NEW YORK

POSTAGE WILL BE PAID BY ADDRESSEE

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
 - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Please do not staple

GC31-6787-02
INTERNATIONAL BUSINESS MACHINES CORP
ATTN: Susie Sanchrez
555 Bailey Avenue
M46A/H251/SVL
San Jose, CA 95141-9989
Cut or Fold
Along Line

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_

_

_





IBM@
Program Number: 5655-L03
GC31-6787-02

*07GC31678702*


	About this book
	Who should read this book
	Conventions and terminology used in this book
	Terminology used in this book
	Service updates and support information
	Using LookAt to obtain message explanations
	Where to find information
	Accessibility features
	Navigating in a workstation panel
	Copying and pasting while using the workstation interface

	How to send your comments
	Summary of Changes

	Part 1. Introduction
	Chapter 1. About the SCLM Suite Administrator Workbench
	Support for Enhanced Access Control for SCLM Administration
	Hardware and software requirements
	Hardware requirements
	Software requirements


	Part 2. Installation and Customization
	Chapter 2. Planning for Installation
	Gather the required information
	Decide how you will use the product
	Install any required products and check the maintenance level of your installed products
	Customize the software
	Involve the appropriate people

	Chapter 3. Installing and Customizing the Host Component
	SMP/E installation
	Installing and customizing the MVS component
	APF authorization 
	Customizing AUZUNPAX
	Customizing AUZFLMRN
	Customizing the AUZ CLISTs

	Customizing the USS components
	Customizing IBM Workload Manager (WLM)
	Customizing setup.sh and ispf.sh 
	Batch program to customize setup.sh and ispf.sh
	Customizing setup.sh 
	Customizing ispf.sh

	Additional USS customization requirements
	Customizing PARMLIB
	Customizing TCP/IP to invoke REXEC
	Customizing RACF
	Specifying TSO(HOLDCLASS) under RACF
	Specifying TSO region size under RACF
	Modifying a user’s OMVS segment

	Customization required to obtain and view Enhanced Access Control for SCLM violations
	Starting an SCLM Suite Administrator Workbench host session

	Chapter 4. The Installation Verification Program
	Running the installation verification program

	Chapter 5. Installing and Configuring the Workstation Client
	Installing the client
	The InstallShield MultiPlatform Installer
	Temporary disk space for the installer
	Uninstalling SCLM Suite Administrator Workbench
	Installing the SCLM Suite Administrator Workbench client into an existing workspace

	Configuring the client component
	Setting preferences for SCLM Suite Administrator Workbench
	Running jobs in batch or foreground
	Setting a data set search filter
	Defining default Types and setting their DCB values

	Setting Remote Systems Explorer preferences
	Setting Enhanced Access Control preferences
	Setting a project filter
	Starting an SCLM Suite Administrator Workbench session

	Part 3. Starting a Session
	Chapter 6. Starting an SCLM Suite Administrator Workbench Session
	Starting a session from the workstation client
	Starting a session from the host

	Appendix A. Messages and Codes
	Appendix B. Accessibility Features of the Workstation Component
	Operating SCLM Suite Administrator Workbench by using the keyboard 
	Other accessibility features

	Appendix C. Notices
	Trademarks

	Bibliography
	Software Configuration and Library Manager Suite
	IBM Interactive System Productivity Facility (ISPF) for z/OS 
	z/OS TSO/E
	TCP/IP
	z/OS UNIX System Services
	Additional Information




